
Wavewin Bitronics Upgrades List - 08/20/2023 

 

Below is a list of all the additions and changes. 

 

Wavewin H.Q.10 - 09/25/2023 

 

1. File Manager (Export File Table): Added a new feature to export the contents of the file manager to  

   a comma delimited CSV file. To export the table select the Export File Table menu option under the Files 

   menu/tab. A dialog is displayed, enter the filename, and select to export the marked files or all files. 

   After the export is complete navigate to the path where the file was saved and double click to open the 

   file in Excel. 

 

 

Wavewin H.Q.9 - 09/06/2023 

 

1. File Manager (Auto Convert to Comtrade): Added a drop down list to select the Comtrade file type to  

   convert the specified file extensions. Also, added a checkbox to include the SEL settings in the  

   converted Comtrade .HDR file/section. 

 

2. Device Manager (Import File): Added a new section in the Import dialog to Auto Fill the Device Number  

   and Session numbers when importing into a new Device Manager table. The auto fill will only work when  

   the device manager table is empty. It also, allows for specifying the start number for both the  

   device number and session number.  

 

 

Wavewin H.Q.8 - 07/24/2023 

 

1. File Manager (Popup Menu - Rename): In the Ribbon system the File Manager's rename popup menu option 

   was not displaying the rename dialog. The Rename name displayed in the popup menu was different  

   than the name in the popup menu code. 

 

2. Data Plotting (Print PDFs): Corrected a problem with the waveform files being printed as straight lines. 

   The equations to calculate the scale for each waveform was using integer values resulting in a 0 scale  

   factor. It now uses floating point values for the calculation. 

 

3. File Manager & Data Plotting (Save As Comtrade): When converting an SEL compressed or ASCII file to 

   Comtrade the settings section of the SEL file is saved now to the Comtrade .HDR file/section.  

 

 

Wavewin H.Q.7 - 06/26/2023 

 

1. Data Plotting (Invert Analog Channel): Corrected a problem when channels are inverted and the properties  

   dialog is opened and saved. The channel scale factors were reverted back to their original values.  

 

2. Data Plotting (Calculated Trigger Position): Added a new option in the data plotting window to show a  



   purple dotted line with a fuchsia triangle at the bottom showing the calculated trigger position in  

   the file. The new option is in the Properties dialog under the Display Settings tab. 

 

3. Data Plotting (Number of Cycles from Trigger): Added a new option in the process template engine. The  

   new option allows for selecting the number of cycles the data bar is positioned from the trigger 

   position. The select cycle option is in the File Manager Display dialog under the data plotting tab. 

   The four options are 1, 1.25, 1.75 or 2.00 cycles.   

 

4. Data Plotting (Harmonic Analysis Report): Corrected a problem with the harmonic analysis report with 

   Comtrade files that have the sampling frequency set to 0. When the sampling frequency is set to 0 in  

   the CFG file the sampling frequency is calculated using the time at each sample. This causes the  

   sampling frequency to change across cycles. Instead of using the maximum harmonic to calculate the 

   0 harmonic it now uses 0 for the calculation. 

 

5. Device Manager (FTP Driver): Corrected a problem when parsing new files to collect using the FTP driver. 

   The parsing was not picking up dates that have a single digit day. This problem was introduced in the 

   H.Q.4 release dated 12/01/2022. 

 

 

Wavewin H.Q.6 - 02/07/2023 

 

1. Data Plotting (Process Templates – Rename DIG Files): Added a new option to rename all DIG files before  

   processing a new batch of waveform files for the process templates feature. To rename the DIG files  

   there are four new fields in the Display dialog under the Data Plotting Tab. The first field called  

   Rename After allows for selecting what to do with the DIG files before processing new files. The  

   two options are, No – do not rename and Yes, rename the files. All DIG files will be renamed using  

   the long file naming format (Comnames). The three remaining fields are used to rename the files. 

   Enter the timecode where the files are located along with the station name and device name. 

 

 

Wavewin H.Q.5 - 01/17/2023 

 

1. Data Plotting (Process Templates – Delete Files): Added two new options to the process templates.  

   To save on disk space there is two new drop down options in the Display dialog under the Data Plotting 

   Tab. The first is Delete After processing a file. The 3 options are: No, Yes and Only Non Fault files.  

   The second option is Delete No Line Group. There are two options: No and Yes. This will delete any  

   files that do not have a line group or encounter an error opening the file.  

 

2. Data Plotting (Line Groups): When reading lines from a line group file spaces after the Positive  

   and Zero Sequence values was causing errors when converting to a real value. All spaces before and  

   after are deleted before the conversion.   

 

3. Data Plotting (Process Templates - PDF): Added a new option for creating Fault Location PDF files. 

   The new option will create a PDF if a Fault Type is detected. The four options for creating a  

   fault location PDF are: All Files, No Files, Breaker Operated & Fault Type or just Fault Type.   



 

4. Data Plotting (Process Templates - Digital): Replaced all illegal characters with a - from the digital  

   channel titles before writing to the DIG file. The illegal characters was causing separator issues.  

  

 

 

Wavewin H.Q.4 - 12/05/2022 

 

1. Device Manager (FTP/SFTP): Made a number of improvements to the FTP and SFTP extract driver for  

   Comtrade files. 

     Before any files are extracted the list containing the latest files are sorted by filename. This  

     will group the Comtrade CFG, DAT, HDR and INF files in order.  

 

     Changed the way the CFG date and time is implemented across Comtrade Files. In previous versions  

     the CFG fault date and time was held in memory until the DAT, HDR and INF files are extracted.  

     If the system is shut down before extracting the DAT, HDR and INF files then the CFG file was not  

     matching the remaining Comtrade files. It now updates the DAT, HDR and INF files directory listing  

     in memory to match the CFG date and time. This list is saved to the DEV_###.FTP file located 

     in the directory where the device configuration files located right after extracting the CFG file.  

     This ensures that the CFG file will match the remaining Comtrade files. 

 

     Added error reporting. If an error is encountered either connecting to the server or getting 

     a directory list or extracting a file. Each error is reported in the debug.fil file located in 

     the path where Wavewin is running. The error format is:  

       Date Time – Protocol Error on Device ## at Port ## Error Type 

       11/30/2022 22:09:00.077 - FTP Error on Device#: 66 at Port#: 43 Error = Time Out. 

 

     When a directory listing is received from the server it will only list the date and time of the 

     files generated in the last 6 months. All other files only have the date, no time. See the example 

     below: 

 

      -rw-r--r--    1 server    server         7090 Nov 26 20:17 040219,062250673,5,OC SW,BKR 

BUS1,Softstuf,,999.00,$$$$,CG T.CFG 

      -rw-r--r--    1 server    server       507868 Nov 26 20:17 040219,062250673,5,OC SW,BKR 

BUS1,Softstuf,,999.00,$$$$,CG T.DAT 

      -rw-r--r--    1 server    server          259 Nov 26 20:17 040219,062250673,5,OC SW,BKR 

BUS1,Softstuf,,999.00,$$$$,CG T.HDR 

      -rw-r--r--    1 server    server         2998 Sep 26  2018 040226,131325030,5,South Station,DFR 

TR16,,,,,,20925.CFG 

      -rw-r--r--    1 server    server       593134 Sep 26  2018 040226,131325030,5,South Station,DFR 

TR16,,,,,,20925.DAT 

      -rw-r--r--    1 server    server          620 Sep 26  2018 040325,191158635,+3S,MARA,250,Electric 

Company,,,,.CFG  

      -rw-r--r--    1 server    server       398502 Sep 26  2018 040325,191158635,+3S,MARA,250,Electric 

Company,,,,.DAT    



 

     Wavewin will only collect files that have both the date and time. All other files are ignored.     

 

 

Wavewin H.Q.3 - 11/07/2022 

 

1. Data Plotting (Process Templates – PDF): Only create PDF files if a breaker operated and there is  

   a valid fault type. 

 

 

Wavewin H.Q.2 - 10/24/2022 

 

1. Data Plotting (Process Templates - Duration): Corrected a problem when calculating the duration of  

   the faulted phases. Defining SAC channels inside a line group was causing the duration to be added  

   every time a SAC channel was calculated. Instead of adding the duration the software now keeps a  

   pointer to the beginning of the fault and a pointer to the end of the fault. The duration is calculated  

   from the difference in samples from the two pointers.   

 

3. Data Plotting (Process Templates - PDF): When processing files a PDF file can be created. The function  

   to produce the PDF file is also the same function that displays the summary file inside the DIG table. 

   When a Summary is requested inside the DIG table a single ended fault location is performed depending  

   on the fault type. It also looks for the far end of the line a performs a double ended fault location. 

   When processing files it was trying to find the far end of the line which is not available during the  

   file processing and was causing an access violation error. The function has been modified to only call 

   the double ended fault location from inside the DIG table.  

 

4. Data Plotting (Process Templates - Negative & Positive Sequence Values): Added the unit prefix to the 

   negative & positive sequence value calculations for the process templates. In previous versions the  

   prefix was not being applied for channels that have a prefix equal to kilo.  

       

 

Wavewin H.Q.1 - 09/25/2022 

 

1. Line Group Builder (Time Adjustment): Added a new field in the Line Information tab to add a time  

   adjustment to the line group file. The field is added to the end of the line group file. The name of the 

   field is call TIMEADJUSTMENT=. To minus a time from the file’s time add a minus sign before the time 

   adjustment number. 

 

2. Data Plotting (Process Templates): Added the Three-Phase and Multi-Phase single ended fault location 

   engines to the DIG summary window.  

 

3. Data Plotting (TimeAdjustment): Read the time adjustment field from the line group file if it exists. 

   Apply the time adjustment to the files time before the file is opened.     

 

 



Wavewin H.Q.0 - 09/01/2022 

 

1. Data Plotting (Process Templates): Added a new command to the Templates to define the phase rotation 

   of the channels. In the Line Group builder a new field was added to the Line Information tab called 

   Phase Rotation. This field is saved to the line group as PhaseRotation=ACB. The line rotation can be  

   ABC or ACB. In the template the new command is called <PHSROT>. This command will write the Phase  

   Rotation to the DIG files. 

 

2. Data Plotting (Process Templates): Added a new command to the Templates to define the Remote Device  

   name. In the Line Group builder a new field was added to the Line Information tab called 

   Remote Device. This field is saved to the line group as RemoteDevice=. In the template the new command  

   is called <RDev>. This command will write the Remote Device name to the DIG files. 

 

3. Data Plotting (Invert Channels): Added a new option from the data plotting’s right click popup menu to  

   automatically invert all the marked analog channels. To activate first marked the desired analog  

   channels using the spacebar or mouse, next right click on the analog channel table and select  

   the Invert Marked Channels menu option. 

   All of the marked channels scale factor will be multiplied by -1. To restore the original mark the  

   channels again and select the popup menu option Invert again.  

 

4. Device Manager (SFTP Driver): Added extra protection to catch invalid connection configuration and 

   invalid Remote Paths. If a connection fails or the remote path does not exist on the server an error 

   is written to the debug.fil file located in the same path where Wavewin is running.  

 

 

Wavewin H.P.21 - 07/20/2022 

 

1. File Manager (Append CSV Files): Changed the Append Log File command to append all marked like CSV 

   files on the active path from the file manager. To append a number of CSV files first mark the files 

   then select the Append CSV Files from the Options/Report menu.  

 

2. Data Plotting (SEL Views): Added support to have views specific to each type of SEL Relay.  

 

 

Wavewin H.P.20 - 06/17/2022 

 

1. Data Plotting (Mark and Save): Added a new analog command to the Mark and Save window and the Process 

   Templates. The new Z commands extracts and saves the Frequency calculated from the 3rd to the 4th cycle. 

   To extract the Frequency use the following command: <^1:F:8>. The ^1 specifies the first visible channel.  

 

 

Wavewin H.P.19 - 06/12/2022 

 

1. Data Plotting (Auto Process Templates): Added 5 new command to write the DME fault location variables  

   parsed out of the DME Comtrade *.INF file. The Z1 and Z0 Magnitude and Angle Line Impedance values and 



   Fault Location and Line Length are parsed out of the INF file if they exist in the file. The 5 new  

   template command are: 

 

   -> DME-LINELEN,   DME-FAULTLOC,   DME-Z1MAG,   DME-Z1ANG,   DME-Z0MAG,   DME-Z0ANG 

      <DMELL:8>,     <DMEFL:8>,      <DMEZ1M:8>,  <DMEZ1A:8>,  <DMEZ0M:8>,  <DMEZ0A:8> 

 

 

Wavewin H.P.18 - 06/03/2022 

 

1. File Manager (DIG Files): Corrected a problem when passing a file with extension different than the  

   Comtrade file extensions. The system was marking it as a processed file by adding a ,WWD to the end of  

   the filename. The system was corrected to only add a ,WWD to the end of a Comtrade file.  

 

 

Wavewin H.P.17 - 05/24/2022 

 

1. Data Plotting (Mark and Save): Added 2 new analog commands to the Mark and Save window and the Process 

   Templates. The W and V extracts and saves the MWatts and MVars at the data bar or the reference bar. 

   To extract the MWatts and MVars specify the Voltage and Current Channels first followed by a W or V. For 

   example <^1,^4:W> or <^1,^4:V>.  

 

 

Wavewin H.P.16 - 05/15/2022 

 

1. Data Plotting (Auto Process Templates): When a Comtrade file is processed using the Auto Process Templates  

   feature it first checks to see if a line group file exists for the file. If a line group file does not exist 

   then it will skip the file. Support was added to the check for line group file feature to include the device  

   name in the file. In previous versions the line group file only contained the station name in the  

   filename, such as Station-A.LNG. To expand to multiple devices per station the Device name was added, such 

   as Station-A,Device-A.LNG. The Station name and the Device name are read from the Comtrade’s .CFG file. 

   The first line in the CFG file list the station name, device name, Comtrade version number. The  

   Station-A.LNG and the Station-A,Device-A.LNG are both supported.  

 

 

Wavewin H.P.15 - 05/10/2022 

 

1. Data Plotting (Up Sample): Added up sampling to the Auto Convert to Comtrade and the /Comtrade passed 

   parameter. Up Sampling is specified in the Change Frequency dialog. If the Always Open Frequency check box 

   is checked then before saving the converted file to Comtrade it will change the frequency to the  

   specified frequency in the Always Open Frequency edit box.  

 

2. Device Manager (Automatic Update Properties Dialog): Modified the User_Params.ini file to include the 

   star passwords and IPs. When the user_params.ini file is saved to the path were Wavewin is running the 

   next time it starts it will read the user_params.ini and update all the specified fields in the  

   Properties dialog and the Star Password and IP address in the Display dialog. 



 

3. Device Manager (Bitronics DIR Config and SOELOG.TXT): Added a new driver to extract the Config setting 

   Zip file and the SOELOG.TXT file. The new driver will first create the DEV_###.FTP file in the path  

   where the Device configuration files are located. This file contains the Config and SOELOG.TXT files.  

   The driver will then connect to the device and request to extract the Config file then the SOELOG.TXT 

   file. Both files will be named using the IEEE long file naming format with the original filename in the 

   first user fields.  

 

 

Wavewin H.P.14 - 04/20/2022 

 

1. Data Plotting (Analog Channel Titles): Increased the maximum characters per analog channel title from  

   50 to 80. 

 

2. Data Plotting (Line Groups): Added support to have the station,devicename.LNG as the devices line group 

   filename. In previous versions the Line Group file was named station.LNG. Expanding the name to include 

   the device name allows for supporting multiple devices in the same substation. The station name is read  

   from the first field in the first line of the Comtrade .CFG file or section. The device name is read  

   from the second field in the first line of the Comtrade .CFG file or section. The fields on the first 

   line in the CFG file are separated by a comma.  

 

3. Device Manager (Star Passwords): Added starring out the IP addresses for the Star Passwords feature. The  

   IP addresses are starred out in the Device Manager and Configuration dialog along with the export feature.   

 

4. Device Manager (ZModem Driver): Corrected a problem when unzipping files collected using the ZModem 

   driver. The unzip feature was tagging the unzipping of the files with an error causing the zip file to be 

   renamed with an Error indication and not deleted from the save path.        

 

 

Wavewin H.P.12 - 04/03/2022 

 

1. Data Plotting (Process Templates): Added a new feature that will write the digital channel title to the  

   report file using Breaker or Event script codes, example [B01:H] or [E02:H]. The H after the colon indicates 

   to write out the digital channel header. 

 

2. Data Plotting (Process Templates): Added a new feature that will write the digital channel status to the  

   report file using Breaker or Event script codes, example [B01:S] or [E02:S]. The S after the colon writes an 

   “A” if the digital channel had a change of state or an “N” if there was no change of state. 

 

3. File Manager (Save As): Changed the Save As Comtrade in the File Manager to a generic Save As feature. The 

   Save As Comtrade menu option under the Options menu has been changed to Save As. The new Save As dialog allows 

   for directly selecting the Save As format (Comtrade 1991, 1999, 2013 Ascii or Binary, RMS, Instantaneous  

   Values, Vector Values and Summaries). Also added a Save As menu option under the File menu. The new Save  

   As dialog has a drop down list box to select the format and radio buttons to select the files to process. 

 



4. Data Plotting (Process Templates): Added protection from having duplicate templates added to the  

   process templates when using the batch mode processing or using the Process Template dialog. 

 

 

Wavewin H.P.11 - 02/02/2022 

 

1. Device Manager (SFTP Client): Added a new file transfer protocol to extract files from an SFTP Server.   

   The new SSH FTP Client works the same as the current FTP Client with the addition of password authentication. 

   To specify  an SFTP connection select Ethernet in the connection Types section of the Device Configuration 

   dialog. Then select SFTP in the Protocol list box.  The SFTP Client connects to the SFTP Server using  

   the username and password defined in the device configuration dialog. Once the connection is established 

   the SFTP Client requests a DIR list for the specified remote path. It then parses each file/folder in the 

   list. All files that have a date and time greater than the Current date and time displayed in the Change  

   Polling Start Date & Time dialog are marked for retrieval. 

 

2. Data Plotting (Restore Original View): Added a new feature that will restore the analog channels, digital 

   channels, phasors, and the analog table back to the original view when the file was first opened. To  

   restore the original view select the Restore Original View menu option under the View menu in the Menu 

   based system or click the Restore Original View icon in the View section under the Waveform tab in the  

   Ribbon System.  

 

3. Data Plotting (Line Groups): Increased the number of lines contained in a Line group file from 25 to 50. 

 

 

Wavewin H.P.10 - 12/01/2021 

 

1. Device Manager (SSHClient): Replaced the existing SSHClient component  with a more reliable component.  

   The previous SSHClient was designed to work with ASCII communications only. The new component supports  

   both ASCII and Binary communications. The new component also has a better support team and the old  

   component is no longer supported. 

 

2. Data Plotting (Append Files): When Appending files only the files that have matching analog and digital 

   channel titles are appended. The scale factor has been added as an additional check to make sure all  

   analog channels appended have matching scale factors as well. 

 

3. Data Plotting (Sort Digital Channels): Added a new feature that will sort the Digital Channels according 

   to the change of state. This new feature will sort the first change in state in Ascending order or sort 

   the first change in state in Descending order. There is also an option to restore the order of the  

   Digital Channels when the file was first opened. In the menu system there is a new submenu under  

   the Channels menu called Sort Digital Channels and in the ribbon system a new drop down menu was  

   added to the Channels tab under the Arrange section. 

 

4. Data Plotting (Sequence Components Calculator): Added an option inside the Sequence Components calculator 

   to always use the displayed channels that are selected in the voltage and current drop down lists.  

   A new checkbox has been added under the phasor diagram to specify that the channels selected in the  



   drop down boxes be preselected when opening the sequence components calculator. 

 

5. Data Plotting (Fast SACs): Changed the name of the positive and negative sequence components Fast SACs 

   titles to be Time Pos Sequence and Time Neg Sequence. This will clarify that these Fast SACs are time 

   based equations. 

 

 

Wavewin H.P.9 - 08/11/2021 

 

1. Device Manager (Long Filenames): Added support to remove all illegal characters from the Comnames 

   Filenames when saving a file that was composed from data extracted from the device.  

 

 

Wavewin H.P.8 - 06/14/2021 

 

1. File Manager (IEEE Comnames): Added support to handle the IEEE Comnames long name format from SEL 

   devices. The SEL devices are formatting the IEEE Comnames as: 

     20210610,11.35.37.289,-6,PORTSMALL 345,XYZ_420NE,X POWER.dat 

   The format is including the 4 digital year in the first field and adding dots between the time fields. 

   Wavewin now checks if the date field is greater than 6 fields. If it is greater than it reads  

   the date starting at the 3rd character. It also checks if dots are in the time field, if yes then 

   it ignores the dots. These files are now displayed correctly in the File Manager. 

 

3. Create SER Files (Substation and Device Columns): When creating the SER files it now takes the  

   Station and Device fields directly from the IEEE Comnames files instead of from the CFG files 

   for Comtrade files. 

 

2. Device Manager (Baud Rate and Passwords): Added an option to quickly change the baud rate and level 

   1 password for multiple devices. There is a new option in the Device Manager right click popup menu 

   called Set Password and Baud Rate. When the dialog is displayed there are two options on what devices 

   to change, All Devices or Marked Devices. If there are marked devices in the table then the Marked  

   Devices radio button is automatically checked. If there are no marked devices in the table then the 

   Marked Devices option is disabled. The Baud Rate field is defaulted to no selected option and the 

   password field empty. If there is no change need to the baud rate field leave the selection as empty. 

   Same with the password field if it is empty then no changes will occur.  

 

 

Wavewin H.P.7 - 05/18/2021 

 

1. Device Manager (GE SR Relays): Modified the GE SR Relay driver to have the option to only extract 

   the waveform files and bypass the SER extraction. Change the SR driver from TXCOMMAND=GE-SR-RELAYS to 

   TXCOMMAND=GE-SR-RELAYS-W 

 

2. File Manager (Create SER Files): Added code to populate the Time Code field inside the SER report 

   file with the Time Code located inside the ComNames Property dialog only if the time code is not  



   available in the original waveform filename.  

 

3. Data Plotting (Replay Plus Driver): Corrected a problem when reading the Sampling Frequency from 

   The Replay Plus .DAT file. 

 

 

Wavewin H.P.6 - 04/20/2021 

 

1. Device Manager (Extract SEL Files): Added extra checking when extracting the Date and Time from an 

   an SEL CEV compressed format. Wavewin looks for the following fields in the header section of the SEL 

   compressed format: 

     “Year 

     “Month 

     “Day 

     “Hour 

     “Min 

     “Sec 

     “Msec 

  In a SEL relay being polled the “Sec was included in the FID= Serial line. This caused Wavewin to pick 

  up the field below the FID= as the Seconds field for the date and time. The field was not a valid second 

  and the extracted files were not being saved because the field being used as the second had invalid filename  

  characters. To correct this Wavewin now validates each date and time field. If each date and time field  

  does not convert to a number then it looks for the occurrence of the date and time fields above.     

 

2. Device Manager (Create SEL Fault Reports): When saving the Fault Summary .SLS files the target information 

   was inserted before the filename field. The target has been removed from the Fault Summary file.   

 

 

Wavewin H.P.5 - 04/09/2021 

 

1. File Manager (Auto Create SER Files): Modified the Auto Create SER file to create the SER table to 

   conform with the NERC PRC-002 SER Format. The previous versions were creating the following table columns 

   in the SER file: 

      Substation, Device, State, Trigger Date, Trigger Time, Chan. #,Channel Title 

   The new table columns are: 

      Date, Time, Local Time Code, Substation, Device, Channel Title, State 

   The local time code column will only be populated in the SER file if the original file is in the IEEE  

   Comname filename format. The 3rd field in the Comname filename contains the Time Code. If the time  

   code exists in the original file then it is used to populate the time code column in the SER file.   

 

 

Wavewin H.P.4 - 03/29/2021 

 

1. File Manager (Auto Rename Files): Activated the Auto Rename Files when Wavewin is ran if include 

   sub-folders is not selected. The Auto Rename was only activated if include sub-folders was checked.  



 

2. Data Plotting (RMS Calibrated Channels): Corrected a problem when selecting RMS calibrated data type 

   from the Properties dialog inside the data plotting window. It was relying on the setting defined in 

   the Driver Configuration dialog located in the File Manager table. 

 

3. Data Plotting (SEL Driver – Digital Channels): Added support to display digital channels that are not  

   a multiple of 8. The SEL CEV format has always defined the number of digital channels to be multiples of 

   8, one bit per channel. A file we recently discovered had 124 digital channels. In previous versions the 

   Last 4 bits were not being processed.   

 

 

Wavewin H.P.3 - 03/09/2021 

 

1. File Manager (Auto Rename Files): Added more support to avoid runtime errors when the file format is  

   not correct or incomplete. Also, if the station name and device name cannot be found in the file then 

   it is marked as unable to rename. 

 

 

Wavewin H.P.2 - 03/04/2021 

 

1. File Manager (Auto Rename Files): Added a 4th directory for moving all files that have encountered  

   errors when trying to rename a file. The new path is called the Error path. This prevents from 

   trying to rename the files every time the process is ran.  

 

 

Wavewin H.P.1 - 03/01/2021 

 

1. File Manager (Auto Rename Files): Added support to replace all filename illegal characters in the 

   station and device names with a dash (-) before renaming the files. Also, removed all non-printing  

   ASCII characters from the station and device names. Added more protection to the SEL display driver  

   to avoid access violation errors when the file format is not correct. When renaming the files it now 

   checks to see if the file already exists in the destination folder, if it exist then the file is 

   deleted in the source folder and the rename is bypassed. 

 

 

Wavewin H.P - 02/17/2021 

 

1. Device Manager (SEL Event Extensions): Added code to add the proper extension to an extracted SEL  

   event file. If the first 3 digits of the outgoing command is CEV then the extension will be CEV else 

   it is defaulted to EVE. 

 

2. File Manager (Auto Rename Files): Added support to bypass all error message boxes being displayed during  

   the rename process. Also, changed the way the rename process works. In previous versions it would first  

   move the files from the source path to the archive path then copy the files to the destination path. 

   It would then rename the files in the destination path. A number of requests ask to leave the files in 



   the source path if an error occurred reading the files. So it now copies the files from the source path 

   to the destination path and if the rename is successful it then moves the files from the source path  

   to the archive path and deletes any files that encountered errors from the destination path. This way 

   all files that were not successfully renamed remain in the source path.     

 

 

Wavewin H.N.6 - 02/10/2021 

 

1. Data Plotting (SEL Event Files): Added support to bypass an error when there are less than 50 lines  

   from the start of the event to the end of the file.   

 

 

Wavewin H.N.5 - 01/26/2021 

 

1. Device Manager (Relay Tech Configurations): Created a generic polling configuration for relay techs to  

   poll relays in the station without having to edit the configuration to add the station and device names. 

   The station name and device name for each record in the device manager lists the type of data to retrieve 

   from the relay. For example, one record will have Compressed Raw in the Device Name field and Event in 

   the Station name. When the device is activated to poll the relay will download all the new Compressed 

   Raw event files from the relay and name the event files using the IEEE Comnames format. The device name 

   and station name will be automatically populated with the Relay ID and Station ID fields listed in the 

   event file. Below are examples of the Relay and Station Fields defined in a compressed format and an 

   ASCII format located in the event file. When an event is extracted from the relay the SEL driver will 

   automatically look for the Relay and Station ID fields and put the fields inside 2 variables: RID and 

   TRMID. The RID variable will replace the Device field in the IEEE long filename and the TRMID variable 

   will be used for the Station field in the filename. The Device and Stn-Group fields will be added to the 

   IEEE long filename in the 7th field, right after the Company Name field, see the example filename below.  

 

   Wavewin will only perform the automatic naming of the files using the Relay and Station ID fields from 

   inside the event files if a file named Relay_Techs.INI exists in the path where Wavewin is running from. 

   The Relay_Techs.INI file lists all the possible titles a relay would use to label the Relay and Station 

   ID. If a relay uses another title to represent the Station and Relay ID’s add them under the proper 

   section. The Relay_Techs.INI file lists all the possibilities for the Relay IDs under the [RELAYIDS] 

   section and all the possibilities for the Station IDs under the [STATIONIDS] section. The two sections 

   must be separated by a blank line. See the Relay_Techs.INI File Contents section below to see the format of 

   the file. 

 

   Compressed Format 

   "FID","RID","SID","03E2" 

   "FID=SEL-421-R113-V0-Z004005-D20050119","Relay 1","Station A","0f13" 

 

   ASCII Formats 

   SID     := "Station A" 

   RID     := "Relay 1" 

 



   RID   =FEEDER 1                       TID   =STATION A    

 

   Example Filename: 

      181003,21272145,-5,Station A,Relay 1,Softstuf,Event-Compressed Raw,100.000,$$$.$$,TRIG.SEL  

 

   Relay_Techs.INI File Contents 

   [RELAYIDS] 

   MID 

   RELID 

   RID 

    

   [STATIONIDS] 

   TID 

   TRMID 

   SID 

 

2. Device Manager (Event File Type Field): Added an option to add event commands to the Event File Type 

   Field’s drop down list using a file called SEL Event File Type.INI. When the Device Manager is open, 

   it will check if the SEL Event File Type.INI exists in the path where Wavewin is running from. If 

   it does not exist then it will create the file with the default event commands that currently exist 

   in the Event File Type drop down list. The Event File Type Field is stored in the Command field. 

   Currently the field stored in the Command field is a letter or number that corresponds to each title 

   listed in the Event File Type drop down box. The current letters are listed below with its corresponding 

   title and outgoing command. 

    

   Storied Letter/Number  Title    Outgoing Command 

   0            Default    EVE # 

   S            Short     EVE # 

   L            Long     EVE # L 

   R             Raw (Unfiltered)   EVE # R 

   C             Compressed Raw   CEV # R 

   X      Compressed Raw L60  CEV # R L60 

   D      Compressed Default  CEV # 

   B      Compressed B Command  CEV # B 

   A      ASCII EVE B Command  EVE # B 

 

   The # in the outgoing command represents the Event number. The system now stores the number that 

   represents the position in the drop down list box. For example, the new stored values are listed below: 

 

   New Storied Number  Title    Outgoing Command 

   0     Default    EVE # 

   1     Short     EVE # 

   2     Long     EVE # L 

   3     Raw (Unfiltered)   EVE # R 

   4     Compressed Raw   CEV # R 



   5     Compressed Raw L60  CEV # R L60 

   6     Compressed Default  CEV # 

   7     Compressed B Command  CEV # B 

   8     ASCII EVE B Command  EVE # B 

 

   Following is what the Command field for an SEL-421 Relay used to be stored in the configuration: 

     0~OTTER~TAIL~0~0~C~IP=196.72.197.177:4097 

 

   The C in the 6th position indicates to use the Compressed Raw event command. The new command now looks like 

   the below: 

 

     0~OTTER~TAIL~0~0~4~IP=196.72.197.177:4097 

 

   The 4 replaced the C and indicates to use the 5th field in the drop down list. The index into the drop 

   down list starts with 0 so the 4 is equal to the 5th field.  

 

   Backward compatibility is also preserved. When the MID window is opened it will check if the Event File 

   Type field stored in the Command field is a letter and convert it to its new number.  

 

   The new SEL Event File Type.ini allows for adding up to a maximum of 50 commands. When the file is read 

   all lines that start with a ; is ignored.  The ; allows for adding comments to the file. The format of the 

   file is the title that will be placed in the drop down list box then the command separated by a comma. 

   Add a # in the outgoing command field where the event number goes. When the command is sent to the relay 

   the system will search for the # in the outgoing command string and replace it with the proper event number.  

 

   It is recommended to compose the list of commands before configuring the devices so the order is preserved. 

   If new commands are needed, add them to the end of the file. If new commands are added in the middle or 

   beginning of the file then existing configurations will not have the proper commands. 

 

 

Wavewin H.N.4 - 12/17/2020 

 

1. Data Plotting (Digital Channels): Increased the Digital Channel title characters from 80 to 90. 

 

2. File Manager (Process Templates): Added 2 new fields in Display dialog under the Data Plotting tab. 

   These 2 new fields are called PDF Width and PDF Height. When running Wavewin as a service the monitor 

   coordinates for the PDF are not exact. These fields allow for changing the width and height to fit the 

   PDF report properly. 

 

3. Device Manager (SEL-FTP Events): Added the ability to connect to a SEL Relay using the TCPIP connection 

   to check if there are new files for download. If there are new files then the FTP connection is used to 

   download the new files. This was required because the level 2 password is used to logon to the FTP server 

   and that causes alarms sent to SCADA. This will eliminate a majority of the alarms by only logging on to 

   FTP server if there are new events to download. 

 



 

Wavewin H.N.3 - 12/02/2020 

 

1. File Manager (Copy Files): Corrected a problem when coping files using the Opposite click popup 

   Menu. The system was activating the move drag and drop. This problem has been corrected in this  

   Version.  

 

2. File Manager (Process Templates): When Wavewin reads a Comtrade file it composes the analog channels  

   titles from the 2nd, 3rd, and 4th fields (ch_id, ph and ccbm) in the Comtrade CFG file. For example if  

   the first 4 fields in analog channel information in the CFG file for channel 1 is: 

        1,A1,A,Feeder 780M - A Phase 

   Then the channel title will be: A1 A Feeder 60M - A Phase  

   The three field are separated by a space. 

   Some DME equipment are changing the information in the first two fields from one fault file to another. 

   If a line group is setup to look for channel titles using a string then some channels are not being  

   found because of the changes. Wavewin now deletes the first 2 fields in the name when searching for 

   the 3 Voltage and 4 Current channels for the line group. 

   Also, the same is true for the digital channels. Wavewin uses 2nd, 3rd and 4th fields to compose the  

   name. The same was applied to the digital channels when searching for Breaker and Event channels.  

 

3. File Manager (Process Templates): Added debug information when a channel defined in a line group 

   cannot be found in the file. The Channel name, the line group and the line group filename is written 

   to a Debug.fil file located in the Wavewin Folder. This works for both analog and digital channel. 

 

4. Data Plotting (Analog Channels): Increased the Analog Channel title characters from 40 to 50. 

 

 

Wavewin H.N.2 - 11/25/2020 

 

1. File Manager (Process Templates): When Wavewin reads a Comtrade file it composes the analog channels  

   titles from the 2nd, 3rd, and 4th fields (ch_id, ph and ccbm) in the Comtrade CFG file. For example if  

   the first 4 fields in analog channel information in the CFG file for channel 1 is: 

        1,A1,A,Feeder 780M - A Phase 

   Then the channel title will be: A1 A Feeder 60M - A Phase  

   The three field are separated by a space. 

   Some DME equipment are changing the information in the first two fields from one fault file to another. 

   If a line group is setup to look for channel titles using a string then some channels are not being  

   found because of the changes. Wavewin now deletes the first 2 fields in the name when searching for 

   the 3 Voltage and 4 Current channels for the line group. 

   Also, the same is true for the digital channels. Wavewin uses 2nd, 3rd and 4th fields to compose the  

   name. The same was applied to the digital channels when searching for Breaker and Event channels.  

 

 

Wavewin H.N.1 - 11/11/2020 

 



1. File Manager (Process Templates): Added code to remove all begin and end blanks from the Station 

   name inside the Comtrade CFG file. If blanks are included in the station name then the line group 

   file will not match. 

 

2. File Manager (Process Templates): Added code to look for the first Breaker or Events that triggered 

   In the line group rather than looking directly adding the digital channel information in the DIG file. 

 

3. Device Manager (Tesla FTP Extraction): Corrected a problem when adding the Tesla original filename to the 

   extracted long filename. If the Add Original Filename field inside the Display dialog under the Device  

   Manager tab is set to YES then the code renaming the files when a Tesla file is extracted was adding the 

   original filename twice at the end of the long filenames. 

 

 

Wavewin H.N - 10/30/2020 

 

1. File Manager (Create SER Files): Corrected an error where the digital data being binned into memory  

   was not being freed which caused a memory leak. 

 

2. File Manager (SEL Fault Reports): When setting up the SEL Fault Reports from the Display dialog 

   in the File Manager the Create Fault Report checkbox field is saved to the system templates  

   and the Report path is saved to the systems Wavewin.ini file. If Wavewin is shut down using  

   the Task Manager then the templates are not saved. The templates are saved upon exit but the  

   Wavewin.ini file is saved when leaving the dialog therefore the SEL Fault Reports will not be 

   created if Wavewin was not exited properly. Saving the templates and the Wavewin.ini file  

   has been added when existing the dialog. 

 

 

Wavewin H.M.17 - 09/17/2020 

 

1. File Manager (Automatically Rename Files): Added a new feature to Automatically rename waveform/load  

   files to the IEEE ComNames format. This new feature monitors a folder for waveform/load files with  

   user defined extensions. When a file is detected in the source path or in its included folders it  

   will first move the original file to the Archive path then read the file’s configuration information  

   and rename the file to the destination path. To activate this feature select the Auto Rename Files  

   option under the Options menu/tab. A dialog will be displayed. Enter the Source Path, click the  

   Include Sub Folders check box if needed. Enter the Destination and Archive Paths. Enter all file  

   extensions (*.DAT,*.CEV,*.CFF) and the scan period. If this feature needs to start when Wavewin  

   runs click the Automatically Start Auto Rename Files at Run Time checkbox. The bottom section of  

   the dialog gives a status update on the activity of the process. It displays the last scan time,  

   the original and Renamed filenames and when the next scan will start in minutes. To start the process  

   click the Start Rename button. 

 

 

Wavewin H.M.16 - 08/29/2020 

 



1. File Manager (Create SER Files): Added a new feature to create SER files for each waveform file. 

   This new feature monitors a folder for waveform files with user defined extensions. When a file is  

   detected it will read the file and create a comma delimited SER file from the digital channel  

   activity. The SER file will have the same name as the original waveform file. To activate this  

   feature select the Create SER Files option under the Options menu/tab. A dialog will be displayed.  

   Enter the Source Path, click the Include Sub Folders check box if needed, enter the file extensions  

   (*.DAT,*.CEV,*.CFF) and the scan period. If this feature needs to start when Wavewin runs click the  

   Automatically Start Create SER File at Run Time checkbox. The bottom section of the dialog gives 

   a status update on the activity of the process. It displays the last scan time, the original and  

   SER filename being processed and when the next scan will start in minutes. To start the process  

   click the Start Create button. To create an SER file with all the digital activity from all processed  

   Waveform files click on the Create a Combined SER File check box. Select or enter the path of the  

   Combined file and enter its filename. This allows for adding the SER information into a database  

   from one single file. 

 

   To create the SER files for each file being processed by the Auto Process Templates add a /SER to  

   each line in the Format files being processed. 

 

2. File Manager (Process Batch Templates): Added the ability to specify a /SER command to create 

   SER files for each file being processed. This allows for creating a SER file for each file being  

   processed without having to run the Create SER Files option.  

 

3. File Manager (Zip Marked Files): Updated the zip compression components. This upgrade now 

   allows including folders in the zip file and for adding a password to the zip file. 

 

Wavewin H.M.16 - 08/29/2020 

 

1. File Manager (Create SER Files): Added a new feature to create SER files for each waveform file. 

   This new feature monitors a folder for waveform files with user defined extensions. When a file is  

   detected it will read the file and create a comma delimited SER file from the digital channel  

   activity. The SER file will have the same name as the original waveform file. To activate this  

   feature select the Create SER Files option under the Options menu/tab. A dialog will be displayed.  

   Enter the Source Path, click the Include Sub Folders check box if needed, enter the file extensions  

   (*.DAT,*.CEV,*.CFF) and the scan period. If this feature needs to start when Wavewin runs click the  

   Automatically Start Create SER File at Run Time checkbox. The bottom section of the dialog gives 

   a status update on the activity of the process. It displays the last scan time, the original and  

   SER filename being processed and when the next scan will start in minutes. To start the process  

   click the Start Create button. 

 

2. File Manager (Zip Marked Files): Updated the zip compression components. This upgrade now 

   allows including folders in the zip file and for adding a password to the zip file. 

 

 

Wavewin H.M.10 - 07/06/2020 

 



1. Device Manager (FTP Get Files): Improved the extraction of Comtrade (.CFG, .DAT, .HDR  

   and .INF) files from an FTP server. The new extraction will open the CFG files an extract  

   the Fault Date and Time from the file and use that date and time to name the long filenames. 

   In previous versions it would use the date and time listed in the DIR extracted from the  

   FTP server. The date and time from the FTP DIR was only accurate to the minute.  

  

2. Data Plotting (Auto Play Waveform): Added three new buttons to the Ribbon and 3 new menu options 

   to the menu system. The new options will auto play the displayed analog and digital channels.  

   The Ribbon’s new buttons are located in the Data plotting's main toolbar and the menu options  

   are under the Data menu. This new feature will move the channels to the left keeping the data cursor  

   fixed at one cycle from the beginning of the display. In the Ribbon system the button  

   to the left of the auto play button is a button to slow the speed of the waveform movement  

   and to the right is a button to increase the speed of the waveform. In the Menu system 

   use the menu options to increase or decrease the speed of the waveform. 

   The auto play Waveform does extensive drawing to the screen. To minimize flicker and  

   slow drawing select a maximum of 7 channels and expand the time scale to see a smooth  

   transition when the analog channels are played. The drawing is done in the background.  

   This allows for marking, deleting, expanding, contrasting, scaling channels and more  

   while the Waveform is being played.  

 

3. Data Plotting (Digital Groups): Added an option inside the Save View dialog to create 

   digital groups. When a record is open, Wavewin will only display the digital channels that  

   changed state. When creating digital groups all of the digital channels may have to be  

   displayed prior to opening the Save View dialog. Before opening the Save View dialog select  

   the All Digital ribbon item in the Waveform tab. This will include all of the digital  

   channels in the Save View dialog. The new Digital Groups section is disabled until the  

   New Group button is clicked. To create a digital group use the Mouse to select the  

   digital channels in the Digital Channel’s list box. Next, click on the New Group button.  

   Once the New Group button is clicked the Digital Group section will be enabled and the  

   Digital Group Name field will have the focus. Type in the name of the new group and hit  

   enter or click the Save button. The table below the Digital Group Name field will be  

   populated with the name of the digital groups in the first column and the number of  

   channels in that group in the second column. When a view is selected with Digital Group  

   defined in the view a new drop down button is added to the Data Plotting main toolbar.  

   The new drop down lists all the Digital Groups in the View. To display a digital group  

   select the group from the drop down menu. By default Wavewin only displays the triggered  

   digital channels for each group. To view all the digital channels in the group click on  

   the All Digital ribbon item in the Waveform tab. 

 

4. Data Plotting (Digital Channels): Increased the maximum number of digital channels from 

   2048 to 4096. 

 

5. File Manager (Auto Convert to Comtrade/ComName Rename): Removed a 14 character limitation  

   for the station and device names in the ComName format when renaming files to the long  

   format either directly from the File Manager or through the Auto Convert to Comtrade.   



 

6. File Manager (Auto Convert to Comtrade): When the auto convert to Comtrade tries to copy 

   waveform files to the destination path it was not coping the support files with the  

   data file. This applied to Comtrade files, Emax files, Transcan file and Rochester files. 

   It now copies all support files to the destination path. 

 

7. File Manager (Change Filename): Added a new option in the File Manager to change the names 

   of the marked files in a path or all the files in a path. The new option is under the File 

   menu in the menu system and under the File tab in the ribbon. The new option is called  

   Change Filenames. This new feature allows for adding new information to the end of a  

   filename or removing characters from a filename. For example if there are pound signs in 

   a number of file that need to be removed open the dialog select the Remove option, type 

   # in the File String edit field then select Marked Files or All Files and click OK. If 

   there are no marked file in the path then the Marked Files radio button is grayed out. 

 

 

Wavewin H.M.7 - 12/17/2019 

 

1. Device Manager (FTP Driver): Corrected a problem when the FTP server sends the list report  

   to the FTP client with just line feeds and no carriage returns. A number of SEL Relays  

   are sending the requested list report to the Wavewin FTP client with no carriage returns. 

   This was causing the client to only see the first file in the list.   

 

 

Wavewin H.M.6 - 10/28/2019 

 

1. File Manager (Auto Convert to Comtrade): Added support to perform a number of tasks  

   for the Source Path, Destination Path and Archive Path. There is a new button in the  

   Auto Convert to Comtrade dialog called Advance. The Advance button displays the Advance 

   Settings dialog. This dialog has 3 sections, one for the Source path, one for the Destination 

   Path and the last one is for the Archive path. The Source path section allows for including 

   Sub-folders when scanning for files to convert to Comtrade. The Destination path section  

   allows for renaming the destination files to be named using the IEEE long file naming format. 

   The Archive path section allows for renaming the archive files to the IEEE long file 

   Naming format. It allows for appending all like files into one Comtrade file for an  

   entire year. If append is selected then the drop down list will be enabled asking what to do 

   with the files that have been appended: Delete the files or Backup the files. If Backup 

   is selected an edit box is displayed to define the path where the files are to be moved to. 

 

2. File Manager / Data Plotting (Append Files): After appending files the number of appended  

   files is added to the data plotting’s window header. For example, if 28 files were successfully  

   appended the final result will be displayed in the data plotting window and the window header  

   will look like:  

     28 Appended Files – the first file’s original name – date and time – Values – (file type) 

   Also, the maximum number of files that can be appended was increased from 100 to 400. 



 

3. Data Plotting (SEMI F47-0706 Chart): Added a new option under the Channels tab called 

   SEMI F47 Voltage Sag Chart. This chart is for Voltage channels only. First mark the  

   desired voltage channels in the data plotting window then select the new option. 

   In the chart each channel is display at the voltage sag level on the y-axis and the duration 

   of the sag on the x-axis. Each channel’s dot is colored the same color as it is plotted in the  

   data plotting window. 

 

4. Data Plotting (3-D Drawing): Added a new option under the Channels tab called Draw 3-D Plot.  

   This Draw 3-D plot will draw a maximum of 3 channels. First mark the desired channels in the  

   data plotting window then select the new option. In the plot each channel’s number, title, 

   maximum and minimum values for the entire signal along with the channel’s fault duration in  

   cycles and milliseconds. Each channel’s 3-D plot is colored the same color as it is plotted in the  

   data plotting window. 

 

5. File Manager (Display Dialog – Analog Table Font Size): Added a new option in the File Manager’s 

   Display setting dialog under the data plotting tab. The new feature allows for setting the Analog 

   Table font size. The options are Sizes: 8, 9 , 10, 11, 12, a4 and 16. 

 

6. File Manager (Display Dialog – Duration): Added a new section in the File Manager’s Display dialog 

   under the data plotting tab. The new section is called Duration Calculation. There are two calculations 

   used when determining the fault duration and sag duration. This section allows for modifying these 

   calculations. When a file is open an RMS value is calculated at each sample using a running RMS  

   calculation. After the first full cycle the duration equations are run on each sample using the 

   RMS values. 

 

7. Data Plotting (Harmonic Power Calculator): Added a new power calculator to the data plotting window. The 

   Power calculator requires 1 marked voltage channel and 1 marked current channel. First marked the  

   required channels then select the Power Calculator option under the Data tab. The calculator  

   displays MWatts and MVars for all harmonics of the signal. The following calculations are used:  

o MWatts = (V * I) O Cos(Øv - ØI)  

o MVars = (V * I) O Sin(Øv - ØI)  

 

8. Data Plotting (Digital Search): Modify the search digital channels feature to mark and move  

   the found channels to the top of the digital channels. 

 

9. Data Plotting (Save View): Defaulted the Save View path to be the path where the file is located. 

 

10. Data Plotting (RMS Calibrated Channels): In RMS Calibrated Files added an option in the analog table  

    popup menu to remove the root 2 multiplier from all of the marked analog channels. In the  

    Channel display window added a * in front of each analog channel’s number to show the channel  

    is multiplied by root 2. 

 

11. Device Manager (Days Idle Report): Added a new report in the Device Manager that displays a table  

    listing the number of days idle since a waveform was extracted. The table columns are, Device #,  



    Group #, Days Idle, Last Date, Station, Title and Driver Name 

 

 

Wavewin H.M.4 - 05/20/2019 

 

1. Data Plotting (Default.LNG): Added support for a Default Line Group to Process Template  

   files for same types of files that have the same analog channel layout but have  

   different station names, such as processing all SEL 311 files. Create a Line Group file  

   called Default.LNG and save the file to the path where all the same types of files are  

   located. 

 

2. Data Plotting (Line Impedance Comtrade): When saving a file as Comtrade Wavewin will 

   save the line impedance values in the Comtrade header file. When the Comtrade file 

   is read it will pick up the Line Impedance values and use them in the Fault Location 

   Dialogs. 

 

3. Data Plotting (Wave Driver): Updated the Wave Audio driver to support the latest  

   format. 

 

4. Data Plotting (Circular Chart): Added support to show negative values in the  

   Circular Chart diagram. All negative values are marked with a small circular 

   at the negative value. 

 

5. Data Plotting (Synchro-phasor Comtrade Files): Added support to read Synchro-phasor 

   (real and imaginary) data saved in the Comtrade file. Wavewin checks the CFG file 

   analog channels for a R or I in the Phase column. If they exist then it will  

   calculate the Phasor from the real and imaginary values and plot the phasors  

   in the Phasor diagram. 

 

6. Data Plotting (Mark and Save): Added two new commands to the template file, + and -. 

   The + command writes the channels maximum value to the values files, and the -  

   command writes the channels minimum value to the values file. Also added the L and G  

   commands for the + and – command to indicate alarm or normal if the value following 

   the L or G is Less than or Greater than.  

   Example: [^1:+:7] for maximum values and [^1:-:7] for minimum values. 

 

7. File Manager (Save As Comtrade): Corrected a problem saving a file from the  

   file manager as Comtrade. The CFG file information was missing the digital 

   channel information. 

 

8. File Manager and Data Plotting (Save As Comtrade): Added support to remove all 

   commas from the Station and Device names before saving the information in the 

   first line in the Comtrade CFG file.    

 

9. Device Manager (RXABORT): Added a new command in the drivers.ini file call RXABORT. 



   Set RXABORT to the maximum time it should take the driver to execute. If it exceeds 

   the RXABORT then it will exit that device and move on to the next device.  

    

 

Wavewin H.M.3 - 03/15/2019 

 

1. Data Plotting (Automatically Append Files): Corrected the auto append when a 

   Comtrade .CFG file is double clicked on. The system was trying to append all 

   common files instead of opening the file in the ASCII Editor. 

 

2. Data Plotting (Mark & Save): Added the Less than (L) and Greater than commands  

   for the new % operator. 

 

 

Wavewin H.M.1 - 02/22/2019 

 

1. Data Plotting (Automatically Append Files): Added support to automatically append 

   a device files within a selected time frame. In the Display Dialog off the File  

   Manager's Option menu there is a new option under the Data Plotting tab to turn on  

   the automatic appending and to specify the time period in minutes. When the automatic  

   appending is On the file manager will scan all IEEE long filenames in the same path 

   and include any files that match the time period, the substation, device and company  

   names. All matching file will be plotted in the same window appended by time. 

 

2. Data Plotting (Digital Toggled Channels): Added support to show only the digital 

   channels that toggled state. In the Display Dialog off the File Manager's Option menu  

   there is a new option under the Data Plotting tab to turn on/off showing only the 

   digital channel's that toggled. 

 

3. Data Plotting (Primary Values): Added support to always open waveform files with 

   Primary values. In the Display Dialog off the File Manager's Option menu there 

   is a new option under the Data Plotting tab to turn on/off showing Primary values  

   when a file is open. 

 

4. Data Plotting (Mark & Save): Added two new template items: F for Harmonic data 

   and % for change in Nominal. Please refer to the help for specific details. 

 

 

Wavewin H.M - 02/03/2019 

 

1. Data Plotting (Move Digital Channels): Added support to move the digital channels 

   using the plus (+) and minus (-) keys. To move digital channels first mark the 

   channels then use the plus key to move them up and the minus key to move them 

   down. 

 



2. Data Plotting (Search Digital Channels): Added support to search for digital channels. 

   To search for certain digital channels select the Search Digital Channels option 

   under the Channel menu. For a single channel search enter the channel title in the  

   search box then press enter. If found the digital channel will be displayed. 

   To search for multiple digital channels enter the channel title in the search box 

   then press the Add button to add it to the Search List. Once all titles are entered  

   press Search. The star Wildcard (*) is accepted in each search. 

   

 

Wavewin H.L.12 - 11/19/2018 

 

1. Device Manager (FTP): Modified the extraction of a single file from the FTP server. 

   The file is extracted once a day. To specify a file add the remote path and name 

   next to the Remote Path field separated by a pipe sign. For example to extract the  

   SOELOG.TXT from the /LOGPATH folder on the server enter the following: 

    \WaveData|\LOGPATH\SOELOG.TXT 

   The first remote path is the path where the files will be extracted that have the  

   extensions entered into the File Extensions field. 

 

2. Device Manager (FTP): Removed the Connect and Disconnect drivers from the FTP  

   LAN-DIRECT, FTP-EVENTS driver. The FTP components automatically connect and 

   disconnect when requesting a List from the FTP server. 

 

3. Device Manager (FTP-MID): Add the polling extensions next to the Remote path 

   in the MID window. Added the byte progress when extracting a file next to the 

   File size field in MID. Added the polling type in the MID window header,  

   Periodic Poll or Poll One Time. 

 

 

Wavewin H.L.11 - 10/24/2018 

 

1. Device Manager (FTP): Added support for wildcards in the File Extension field. 

   To specify files that have certain characters in the filename use wild cards.  

   For example, to extract only TXT that contain TR in the filename add *TR*.TXT  

   to the file extension field. 

 

 

Wavewin H.L.10 - 10/17/2018 

 

1. Device Manager (FTP): Added the ability to extract a single file from the FTP server 

   every time a polling cycle is complete. To specify a file add the remote path and name 

   next to the Remote Path field separated by a pipe sign. For example to extract the  

   SOELOG.TXT from the /LOGPATH folder on the server enter the following: 

    \WaveData|\LOGPATH\SOELOG.TXT 

   The first remote path is the path where the files will be extracted that have the  



   extensions entered into the File Extensions field. 

 

 

Wavewin H.L.7 - 09/09/2018 

 

1. File Manager (Auto Process Templates): Added the ability to process TIS files. 

 

2 File Manager (Auto Process Templates): Corrected a problem when entering a  

  single line group for the /Line= field inside the Template files. 

 

3. Data Plotting (Line Groups - Versioning): Added a new option in the File Manager's 

   Display dialog under the Data Plotting tab to turn On/Off creating a version 

   of the line group files when a file is opened. The default is Off. 

 

 

Wavewin H.L.3 - 07/09/2018 

 

1. Device Manager (File Transfer): Added a 3 option to the TXFILE command in the  

   Drivers.ini file. The existing 2 options are /Move and /Copy. The third  

   option added is /Archive. The /Archive option will move the file to an 

   Archive path under the path were the source file exists. The Archive path is 

   created if it does not exist. 

 

2. Device Manager (Long Filenames): Added 2 new options in the Device Manager's 

   Display Dialog to add the #Device Number or the _Device Number or none after 

   the Device Name in the long filenames when extracting files from a device. 

   Also, add a similar option for the Station name. 

 

 

Wavewin H.L.2 - 07/03/2018 

 

1. File Manager/Data Plotting (Email): Added support to email files from Wavewin  

   using Outlook 2016. 

 

Wavewin H.L - 05/29/2018 

 

1. Data Plotting (Adjust File Time): Added an option to adjust the displayed files 

   date to the existing Adjust File's Time dialog.   

 

2. Device Manager ($File Command): Added support to the existing $File Command to 

   search for key words in a file and put the line in the file into the defined 

   variable. The maximum length of the $File Command is 40 characters. The $file 

   command starts at the end of the file and searches up. 

   Example:  

   RXSTRIP=N00,%^[$C:\Softstuf\SOELOG-(04).TXT:FAULT],D0,C08.X20,Y7,H05,"LOCATION:",@FLOC) 



 

3. Device Manager (RXEXTRACT): Added a new command to Extract a line from a file and 

   using key words. If the key words are found on a line in the file then that line 

   is put into the specified varaiable. The maximum length of the RXEXTRACT Command is  

   255 characters. The RXEXTRACT command starts at the end of the file and searches up. 

   Example: 

   RXEXTRACT=^[^EVE]Trends-SOE\^[^STN]-^[HDR]\^[HDR]-SOELOG.TXT:FAULT,FLOC 

   The Filename and Path is specified between the equal sign (=) and the last colon (:).  

   The Search string is defined between the last colon(:) and the comma (,). The Variable  

   name is defined after the comma (,). 

   Example to display the variable in the MID window. 

   RXSTRIP=N00,D0,C08,X20,Y7,H05,"LOCATION:",%^FLOC 

 

4. Device Manager (Edit Driver): Added a new option to the Device Manager opposite click 

   popoup menu called Edit Driver. This option will open the active Drivers.ini file and 

   display the devices Driver at the top of the ASCII editor. 

 

 

Wavewin H.K - 03/20/2018 

 

1. Data Plotting (Digital Channels): Corrected a problem displaying the digital  

   channels after marked digital channels are deleted. This problem occurred when 

   there are more digital channels listed then displayed.   

 

 

Wavewin H.J - 02/25/2018 

 

1. File Manager (SOE Manager): Add the path to filename column. Clear the SOE Manager 

   before a refresh if the SOEDTB.DTB file does not exist in the source path. 

 

2. Data Plotting (Mark and Save): The last template and Values file is maintained in 

   the dialog if the Auto Process Template was processed or the Mark and Save dialog 

   is opened from the Data Plotting window. 

 

 

Wavewin H.I - 10/25/2017 

 

1. Data Plotting (Single Ended FL - Three-Phase): Added a new tab to the Single Ended 

   Fault Location Dialog to calculate a Three-Phase Fault Location. The Three-Phase 

   calculator requires 3 faulted voltage channels and 3 faulted current channels.  

   Select the faulted channels from the drop down lists and enter the positive line 

   impedance magnitude and angle. Click the Calculate button to see the result at 

   the data bar. 

 

2. Data Plotting (Double Ended FL): Added the results of the double ended fault  



   location for Positive, Negative and Zero Sequence to the Report. Click the  

   Report button to see all 3 fault locations. 

 

 

Wavewin H.H - 10/01/2017 

 

1. Data Plotting (Single Ended FL - Multi-Phase): Added a new tab to the Single Ended 

   Fault Location Dialog to calculate a Multi-Phase Fault Location. The Multi-Phase 

   calculator requires 2 faulted voltage channels and 2 faulted current channels.  

   Select the faulted channels from the drop down lists and enter the positive line 

   impedance magnitude and angle. Click the Calculate button to see the result at 

   the data bar. 

 

 

Wavewin H.G.27 - 09/06/2017 

 

1. Device Manager (Terminal Mode - Inter-Char Delay): Added the ability to  

   pause between port numbers through the Orion. The address field is used to switch  

   between ports on the Orion. If a port number is 2 characters long insert a comma  

   between the two numbers in the address field to pause 1 second insert 2 commas to  

   pause 2 seconds. For example, if the port number is 15 enter 1,5 in the address field. 

   Terminal Mode now handles the comma(s) inserted into the address field to act 

   as an inter char delay for Ethernet connections. 

 

 

Wavewin H.G.25 - 08/08/2017 

 

1. Device Manager (SDC-VAR.INI): Corrected a problem with the SDC-VAR.INI not saving  

   the variables when leaving the MID window. 

 

2. Device Manager (RXVARS): Added a new command in the Drivers.ini file to save the  

   SDC-VAR.INI file. The new command is called RXVARS, to turn on saving the variables 

   add RXVARS=1 to a driver. To turn off saving change the command to RXVARS=0. 

 

 

Wavewin H.G.24 - 08/02/2017 

 

1. Device Manager (Export): Added a message box before exporting devices stating that all  

   CMND, CMND1 and CMND2 passwords will be exported as stars if the Star All Passwords  

   option is set to Yes in the Display dialog. 

 

 

Wavewin H.G.23 - 07/30/2017 

 

1. Device Manager (FTP Driver): Added a new option in the table's Display dialog to 



   add the orginal file name to the extracted long file name as an optional field. The 

   default is set to Yes. To change this option open the Display dialog from the Options  

   menu an click on the Device Manager tab and select Yes or No from the FTP drop down 

   list. 

 

 

Wavewin H.G.22 - 07/17/2017 

 

1. Device Manager (FTP Driver): Modified the FTP driver that automatically assigns a time 

   to a file when only the date is available. Added a check to keep the same time and not 

   increment the milliseconds if the previous file name is the same as the current file  

   name. This will ensure that Comtrade files (.DAT, ,.CFG and .HDR) all have the same 

   date and time. 

 

 

Wavewin H.G.20 - 06/05/2017 

 

1. Device Manager (FTP Driver): Modified the FTP driver to get all files that have a date 

   and/or time greater than the device's last extracted date and time listed in the SDC-HIS.INI 

   file. When a LIST is requested from the FTP server a DeviceNumber.LST file is saved to the 

   Wavewin path. Files listed in the FTP's LST file have a date and time if the file is within 

   the last 6 months. All other files just have a date. In previous versions, Wavewin would 

   only extract files that have a date and time. It now extracts all files that have a date 

   and/or time greater than the device's last extracted date and time. If there is no time 

   then Wavewin will automatically tag the file with 01:00:00.000. And if there are  

   consecutive files with the same date then the millisecond will be incremented. For example, 

   below shows the files with the same date and the date and time Wavewin assigns: 

 

      Date from the FTP Server Date and Time assigned by Wavewin 

      ------------------------  --------------------------------- 

            Jul 25 2016              08/25/2016 01:00:00.000    

            Jul 25 2016              08/25/2016 01:00:00.001 

            Jul 25 2016              08/25/2016 01:00:00.002 

            Jul 25 2016              08/25/2016 01:00:00.003 

 

   This prevents files from being overwritten that have the same date and no time when using  

   the IEEE long file naming convention to name files. 

   

 

Wavewin H.G.19 - 05/17/2017 

 

1. Device Manager (Star Password): Added a new field inside the Table Display dialog 

   to Star all passwords displayed in the Device Manager and the Device Configuration 

   dialog. The new field is called Star All Passwords and is located under the Device 

   Manager tab. 



 

2. Device Manager (Duplicate Dialog Background Color): Added a new field inside the  

   Table Display dialog to change the background color of the Duplicate Device  

   Configuration dialog. The new field is called Duplicate Dialog Background Color and  

   is located under the Device Manager tab. 

 

 

 

Wavewin H.G.25 - 08/08/2017 

 

1. Device Manager (SDC-VAR.INI): Corrected a problem with the SDC-VAR.INI not saving  

   the variables when leaving the MID window. 

 

2. Device Manager (RXVARS): Added a new command in the Drivers.ini file to save the  

   SDC-VAR.INI file. The new command is called RXVARS, to turn on saving the variables 

   add RXVARS=1 to a driver. To turn off saving change the command to RXVARS=0. 

 

 

Wavewin H.G.24 - 08/02/2017 

 

1. Device Manager (Export): Added a message box before exporting devices stating that all  

   CMND, CMND1 and CMND2 passwords will be exported as stars if the Star All Passwords  

   option is set to Yes in the Display dialog. 

 

 

Wavewin H.G.24 - 08/02/2017 

 

1. Device Manager (Export): Added a message box before exporting devices stating that all  

   CMND, CMND1 and CMND2 passwords will be exported as stars if the Star All Passwords  

   option is set to Yes in the Display dialog. 

 

 

Wavewin H.G.23 - 07/30/2017 

 

1. Device Manager (FTP Driver): Added a new option in the table's Display dialog to 

   add the orginal file name to the extracted long file name as an optional field. The 

   default is set to Yes. To change this option open the Display dialog from the Options  

   menu an click on the Device Manager tab and select Yes or No from the FTP drop down 

   list. 

 

 

Wavewin H.G.22 - 07/17/2017 

 

1. Device Manager (FTP Driver): Modified the FTP driver that automatically assigns a time 

   to a file when only the date is available. Added a check to keep the same time and not 



   increment the milliseconds if the previous file name is the same as the current file  

   name. This will ensure that Comtrade files (.DAT, ,.CFG and .HDR) all have the same 

   date and time. 

 

2. Device Manager (SEL Driver): Added an additional check to make sure a space is in front  

   of the LL command if it is not at the start of the line. 

 

 

Wavewin H.G.21 - 06/27/2017 

 

1. Device Manager (SEL Driver): Improved the Line Length extraction when retreiving SEL 

   events file. Added a check to make sure the LL command is followed by a : or =. 

 

 

Wavewin H.G.20 - 06/05/2017 

 

1. Device Manager (FTP Driver): Modified the FTP driver to get all files that have a date 

   and/or time greater than the device's last extracted date and time listed in the SDC-HIS.INI 

   file. When a LIST is requested from the FTP server a DeviceNumber.LST file is saved to the 

   Wavewin path. Files listed in the FTP's LST file have a date and time if the file is within 

   the last 6 months. All other files just have a date. In previous versions, Wavewin would 

   only extract files that have a date and time. It now extracts all files that have a date 

   and/or time greater than the device's last extracted date and time. If there is no time 

   then Wavewin will automatically tag the file with 01:00:00.000. And if there are  

   consecutive files with the same date then the millisecond will be incremented. For example, 

   below shows the files with the same date and the date and time Wavewin assigns: 

 

      Date from the FTP Server Date and Time assigned by Wavewin 

      ------------------------  --------------------------------- 

            Jul 25 2016              08/25/2016 01:00:00.000    

            Jul 25 2016              08/25/2016 01:00:00.001 

            Jul 25 2016              08/25/2016 01:00:00.002 

            Jul 25 2016              08/25/2016 01:00:00.003 

 

   This prevents files from being overwritten that have the same date and no time when using  

   the IEEE long file naming convention to name files. 

   

 

Wavewin H.G.19 - 05/17/2017 

 

1. Device Manager (Star Password): Added a new field inside the Table Display dialog 

   to Star all passwords displayed in the Device Manager and the Device Configuration 

   dialog. The new field is called Star All Passwords and is located under the Device 

   Manager tab. 

 



2. Device Manager (Duplicate Dialog Background Color): Added a new field inside the  

   Table Display dialog to change the background color of the Duplicate Device  

   Configuration dialog. The new field is called Duplicate Dialog Background Color and  

   is located under the Device Manager tab. 

 

 

Wavewin H.G.18 - 05/01/2017 

 

1. Data Plotting (Change Line Frequency): Added a new dialog to change the Line Frequency of  

   the active data plotting window. The new dialog is accessed from the Data menu under the 

   the Change Line Frequency menu option. 

    

 

Wavewin H.G.14 - 03/27/2017 

 

1. Data Display (Email File): Corrected emailing the wrong file when selecting the email file 

   option inside the data plotting window. 

 

 

Wavewin H.G.13 - 03/20/2017 

 

1. Device Manager (Dialogs): Corrected a number of typos in the Device Manager dialogs. 

 

2. Batch Report (Data Bar): Set the data bar 1.5 cycles from the first RMS trigger in the  

   current channels. 

 

 

Wavewin H.G.10 - 02/14/2017 

 

1. Batch Report (/Template=): Added support for multiple Template files definied on 

   each line in a Batch Mode configuration file. 

 

2. Batch DIG Report (Double Ended): Flipped the order of the Data Plotting Windows 

   when requesting a Double Ended Display. 

 

 

Wavewin H.G.9 - 01/24/2017 

 

1. Fault Report (Comma Delimited Table): Added specfic functionality to the comma delimited 

   table to automatically open fault location reports that have the .DIG extension. The table 

   also allows for viewing a fault location report for each entry in the table. It also 

   allows for automatically opening both ends of a line and displaying the double ended 

   fault location dialog. 

 

 



Wavewin H.G.8 - 12/12/2016 

 

1. Data Plotting (Mark and Save): Added a new template command to calculate the maximum value  

   minus the minimum value divided by 2 ((max-min)\2), example <^3:M>. The new M command works 

   on the entire channel not on a sample bases. The <> or [] brackets can be used. 

 

2. Data Plotting (Mark and Save): Improved the trigger capabilities for the :B, :M, :N and :S 

   commands. The trigger now requires a L or G before the value. L is for less than and G is 

   greater than, <^1,^2,^3:NG5000>. If the result of the :M, :B, :S or :N command is true then  

   Alarm is written to the Values file else Normal is written. 

 

 

Wavewin H.G.7 - 12/02/2016 

 

1. Data Plotting (Mark and Save): Added a new template command to calculate the negative sequence  

   magnitude of 3 analog channels, <^1,^2,^3:N>.  

 

2. Data Plotting (Mark and Save): Added a new template command to set a trigger for the :B. :S and 

   :N commands, <^1,^2,^3:N5000>. If the result of the :B, :S or :N command is greater than the  

   trigger then Alarm is written to the Values file else Normal is written.  

 

 

Wavewin H.G.5 - 10/25/2016 

 

1. Device Manager (SysLog): Changed the connect to Syslog to connect to syslog when the 

   Device Manager is opened and closed when the Device Manager is closed. The write to syslog 

   will check if the connection is open if not then it will reconnect to syslog. In  

   previous versions the syslog connection was opened before writing and closed after 

   writing. 

 

2. Device Manager (Lock): Added support to lock the Events path, Events Browse button, 

   Message path, Message Path Browse button, Disk Limit field and the 4 Syslog fields 

   when Lock is set to On. 

 

3. Device Manager (LogCommand - Syslog): Added support to write all Log Commands to the 

   Syslog. In the Drivers.ini file set the LOGFILE=SYSLOG. This indicates to write all 

   log commands to the Syslog not to a file. 

 

 

Wavewin H.G.4 - 10/07/2016 

 

1. Data Plotting (Harmonics): Modified the Harmonics window to not show the mirrored Harmonics. 

   To display the mirrored harmonics open the properties dialog select the Display Settings 

   tab and select ON for the Mirrored Harms field. 

 



 

Wavewin H.G.3 - 09/14/2016 

 

1. Data Plotting (Line Groups): Added support to plot up to 10 Software Analog Channels (SAC) 

   per line group. The SAC channels are calculated when the line group is selected. 

 

 

Wavewin H.G.2 - 09/06/2016 

 

1. Data Plotting (Single Ended FL): Added support to select the values to plot in the Single 

   Ended Fault Location. A drop down list was added next to the Fault Location results to 

   select either the Fault Location values or Fault Impedance. 

 

2. Data Plotting (Single Ended FL): Added support to always display the fault location results 

   in miles. 

 

3. System (Wavewin Display Coordinates): Added support to display Wavewin maximized if  

   Wavewin was previously displayed in a connected monitor that was removed from the list of  

   connected monitors.  

 

 

Wavewin H.G.1 - 08/28/2016 

 

1. Device Manager (Termnal Mode-Backspace): Added support to handle all backspace commands  

   transmitted from the connected devices. 

 

2. Device Manager (Browse For Folders): Added support to display all network folders in the 

   Browse For Folders Dialog used in the Export Dialog, Search File Contents Dialog and the  

   Device Configuration Dialog. 

 

3. Device and File Manager (Search File Contents): Added checks to make sure the Search Path  

   and Report Path exist before starting the search. Added status fields to show the progress  

   of the search. Also, added a new button to view the results of the search in a comma delimited  

   table. 

 

4. Device Manager (EXIT Command): Added support to only execute the exit command if the ports and 

   mid passed parameters exist. 

 

 

Wavewin H.G - 08/16/2016 

 

1. Device Manager (Backup Syslog): Added two new fields in the Save and Archive (Properties) Dialog  

   to define the Backup Syslog host and Port Number. If these fields are populated then all outgoing  

   terminal commands will be written to the backup syslog. 

 



2. Device Manager (SSH Telnet Client): Changed the SSH Telnet Client protocol name to SSH Client 

   in the Device Configuration Dialog. 

 

3. Device and File Manager (Search File Contents): Added a new menu option to the Device Manager's  

   Option menu and to the File Manager's File menu to Search the Contents of a File. The option  

   is also available under the Device Manager's right click popup menu. The Search File Contents  

   Dialog allows for defining the Search: 

     Start Date - Checks if the File's Save Date is equal to or greater then the Start Date. 

     End Date   - Checks if the File's Save Date is equal to or less than then the End Date. 

     Search Path - Enter the search path. 

     Include Sub Folders - Check to include all sub folder under the Search Path. 

     Extensions - Enter the file extensions to search separated by commas. 

     Search String - Enter the search strings to search for separated by commas. 

     Report Path - Enter the Path where the results file will be saved. The results are saved 

                   to a comma delimited CSV file. 

   Button Options: 

     Save - Save the entered search fields to a txt file. 

     Save As - Save the entered search fields to a new txt file. 

     Open - Open an existing txt file. 

     Search - Start the search. After the search is complete the search dialog is closed and the 

              results will be opened in a comma delimited table. 

     Close - Close the search dialog. 

 

 

Wavewin H.F - 07/26/2016 

 

1. Device Manager (Syslog): Added two new fields in the Save and Archive (Properties) Dialog to 

   define the Syslog host and Port Number. If these fields are populated then all outgoing terminal  

   commands will be written to the syslog. 

 

 

Wavewin H.F.1 - 07/15/2016 

 

1. Data Plotting (LNG Line Groups): Removed the re-processing of the SAC channels when the Adjust Offset  

   is called in the line group .LNG that has the setting Offset=Y. 

 

 

Wavewin H.F - 06/15/2016 

 

1. Data Plotting (LNG Line Groups): Added a new feature in the line group .LNG files called Offset=Y.  

   This new feature will automatically apply the adjust offset to the line group channels when the  

   line group is selected. 

 

2. Data Plotting (Digital Channel Spacing): Added a new feature to allow for changing the spacing  

   between the digital channels. The new option is available in the data plotting properties dialog 



   under the the Display Setting tab. To increase or decrease the spacing between the digital  

   channels select a number from the Digital Height drop down list. 

 

3. Data Plotting (Digital Channel Color): Added a new feature to allow for changing the triggered  

   color portion of the digital channels. The new option is available in the data plotting properties  

   dialog under the the Colors tab. To change the color of the triggered portion of the digital  

   channels select a color from the Digital Triggers Colors drop down list. 

 

 

Wavewin H.E - 06/02/2016 

 

1. Device Manager (SSHTelnet): Added support to connect to a SSHServer. There is a new option in the  

   Device Configuration dialog under the Protocol list called SSH Telnet Client. Enter the IP address,  

   Port Number, Username and Password for the connection.  

 

2. Device Manager (Terminal Mode Control Characters): Corrected a extra space character being transmitted  

   when a CTRL-Char is pressed. 

 

 

Wavewin H.C - 04/29/2016 

 

1. Device Manager (Terminal Mode): Allowed for recursive escape code sequences in terminal mode's  

   programmable funtion keys. 

 

2. Device Manager (Terminal Mode): Allowed for pause commands in terminal mode's programmable funtion  

   keys. 

 

 

Wavewin H.B - 04/03/2016 

 

1. Device Manager (Terminal Mode): Added support to allow for the backspace key when typing in  

   terminal mode. When the backspace key is pressed a Ctrl-H is transmitted to the connected 

   device, the last typed chraracter is removed from the terminal window and the cursor is move  

   one character back. 

 

2. Device Manager (Terminal Mode): Added the reserved function keys AUTO CONNECT and AUTO DISCONNECT. 

   The AUTO CONNECT will be automatically executed when terminal mode is opened. The AUTO DISCONNECT 

   can be manually executed when a terminal session is completed. The AUTO CONNECT automatically  

   executes the commands defined in the AUTO CONNECT function key.  

   Example: 

          Title              TXommand 

          -----              -------- 

       AUTO CONNECT         ACC^[13;CMND;13]PORT ^[ADDR;13]ACC^[13;CMND1;13] 

      AUTO DISCONNECT       ^[04]QUIT^[13] 

 



3. Device Manager (Terminal Mode): Added support to automatically execute the AUTO DISCONNECT when 

   exiting the Terminal Window if the connection is still valid. A message will be prompted  

   requesting the user to wait until AUTO DISCONNECT has completed. 

 

4. Device Manager (Terminal Mode): Added support to read the CMND, CMND1 and the address fields 

   in the function keys. 

 

5. Device Manager (Terminal Mode): Added a new menu option under the Option menu. The new option is 

   Save As. This allow for saving the terminal session to an ASCII text file. 

 

6. Reports (SOE List): Added support to save the Trigger date and time fields as two separated columns  

   when using the Save and Save As menu options. The day, month, year, hour, minute, seconds and  

   milliseconds in the table are separated as single columns for easy search and sort. 

 

 

Wavewin H.A - 03/08/2016 

 

1. Device Manager (FTP-Unzip): Added support to use the Zip Files Date and Time for the long 

   file naming format when an invalid date is returned for the files contained in the downloaded 

   zip file. 

 

 

Wavewin H.9 - 03/03/2016 

 

1. Device Manager (FTP): Added support to read the FTP dir from the ABB REC-650 Relay. 

 

 

Wavewin H.8 - 10/25/2015 

 

1. Date Plotting (Adjust Offsets): Added a new menu option called Adjust Offsets under the Options menu. 

   The Adjust Offsets feature finds the maximum and minimum values between the data bar and RMS bar and 

   applies the following equation to each sample: (max-min)/2)+min. The adjust offsets is applied to the  

   marked analog channels. If no channels are marked then it is applied to all visible channels. 

 

 

Wavewin H.7 - 10/12/2015 

 

1. Date Plotting (Mark and Save: Unbalance): Added a new template command to calculate the unbalance of 3 

   analog channels using the DFT magnitude, <^1,^2,^3:B>. The unbalance command finds the largest and  

   smallest magnitude of the 3 channels, the result is the difference between the largest and smallest. 

 

2. Date Plotting (Mark and Save: Skew): Added a new template command to calculate the skew of 3 analog 

   channels using the angles, <^1,^2,^3:S>. The skew command adds the angles for the 3 specified channels. 

   One of the 3 analog channels must be marked as a reference channel.  

 



3. Date Plotting (Mark and Save: Header): Added a new template command to add a header to the Values file. 

   To add a header to the Values file, define the first line in the template file with <Header>= followed  

   by the header information. For example, the following two lines define the header and the data of the  

   Values file: 

 

         <Header>=  Station, Device, Date, Time, RMS, Angle 

         <Station>, <Device>, <Date>, <Time>, <^1:R>, <^1:P>   

 

4. Date Plotting (Mark and Save: Use Default): Added a new check box in the template section to Use the  

   Default save. The Use Default check box will automatically write the visible analog channel columns  

   separated by commas for all visible analog channels in the Values notepad. The header for each column 

   is added to the values file on the first line. 

 

 

Wavewin H.6 - 09/30/2015 

 

1. Date Plotting (Passed Parameters-Prefault Report): Added two new passed parameters  

   /Line= and /Template="". 

   The /Line= parameter specifies what line group to apply when a file is open using the passed parameters.  

   /Line= can specify a specific line group or ALL which indicates to open all line groups. The  

   /Template="" specifies what template file to use when creating automatic reports. 

    

   Example passed parameter: "c:\files\*.DAT" /Line=All /Template="c:\template\create-report.txt" /Exit 

 

   The above example will open each file with an extension of .DAT, select the first line group then apply 

   the template. It then selects the next line group and applies the template and so on until all line  

   groups have been selected. After all line groups have been selected and the template applied to each  

   line group the software will close using the /Exit command. 

 

   The template report is saved to the same path where the template file is located. 

 

2. Date Plotting (Passed Parameters-On Demand DEFL): Added a new passed parameter to automaically do a  

   double ended fault location. The new passed parameter is FLAuto.RUN. When the software sees the  

   FLAuto.RUN file it opens the file, reads the two fault files path and filename and line groups  

   (if needed). It opens the two files, applies the line groups, tile the two files, opens the double  

   ended fault location window, requests a report then closes Wavewin. 

 

   Example FLAuto.RUN File: 

 

   "C:\Faultlib\041002,130008523800,,Near Side,Transcan1991,.CFF" /Line=F35 

   "C:\Faultlib\041002,130008531157,,Far Side,USI_2002,.CFF" /Line=S23 

 

   The fault report is saved to the same path where the near side file is located. 

 

3. Device Manager (Change Passwords Dialog): Added an option in the User Entered Change Passwords  



   dialog that will show/hide the text entered into the password fields for the 7 level passwords.  

   The new option is a checkbox located at the bottom of the dialog called Show Text. Click the  

   checkbox to show the entered characters. The title of the checkbox will change to Hide Text. Click  

   the checkbox again to hide the entered text. To open the change password dialog select the Change  

   Device Password menu option under the Options menu then select the Specified By User submenu option. 

 

 

Wavewin H.5 - 09/21/2015 

 

1. Date Plotting (Line Frequency): Allowed for the line frequency to be specified as a real number  

   with 2 decimal digits of accuracy.  

 

2. Date Plotting (SAC Angle Calculations): Added phase angle conversion equations to mitigate discontinuity  

   in the plotted traces by ensuring that all angles are represented between -180 and 180 degrees. 

 

 

Wavewin H.4 - 09/05/2015 

 

1. Date Plotting (Edit Mark Analog Scans): Added a new dialog to edit the Marked Scans. The new dialog  

   is accessed from the Edit Marked Scans menu option under the Values menu. The Edit Marked Scans dialog  

   allows for adding comments to each scan and for deleting existing scans. Each comment has a maximum of  

   40 characters. To add a comment double click on the comment fields in the table, the editor will be  

   displayed. The up and down arrow keys will move the editor to the next or previous comment fields. To  

   exit the editor press the Escape key. To view the comments for each scan in the data plotting window  

   mouse over the marked scan tick marked displayed above each marked scan. To delete scans from the list  

   check the box next to the scans then clcik the Delete button.  

 

2. Date Plotting (Double Ended Fault Location): Added a new button to view and save an ASCII report for the  

   fault location. The new button is called Report. The report button will save and display an ASCII report  

   for the current fault location. The report is saved to the same folder where the open files are located  

   and is named in the following format: 

       Current Date, Current Time, Near Side Station, Near Side Line, Far Side Station, Far Side Line,  

       Fault Location.TXT 

   After the file is saved the report is displayed in a rich text editor. The editor allows for adding  

   information to the report. 

    

3. Date Plotting (Single Ended Fault Location): Added a button to view and save an ASCII report for the  

   fault location. The new button is called Report. The report button will save and display an ASCII report  

   for the current fault location. 

   The report is saved to the same folder where the open file is located and is named in the following  

   format: 

       Current Date, Current Time, Station, Line, Fault Location.TXT 

   After the file is saved the report is displayed in a rich text editor. The editor allows for adding  

   information to the report. 

 



4. Date Plotting (Double Ended Fault Location): Added more logic to the untis selection for the line length. 

   If the line length units are selected as percentage then the line length is automatically defaulted to  

   100. 

 

5. Date Plotting (Sequence Components): Corrected the header information for the Sequence Components dialog.  

 

6. Device Manager (Edit the Command Fields): Added a new dialog to edit the 12 available Commands for the  

   selected device. To open the commands dialog select the Commands dialog from the Device manager or right  

   click in the table and select the Command menu option in the popup menu. 

  

 

Wavewin H.3 - 08/05/2015 

 

1. Date Plotting (Mark Analog Scans): Added a menu option and shortcut key to easily mark Analog scans.  

   The new menu option is under the Values menu called Mark Scan. The shortcut key is Ctrl-S.  

 

2. Date Plotting (Navigate to Marked Analog Scans): Added a menu option and shortcut key to easily  

   navigate to the marked Analog scans. The new menu option is under the Values menu called Next Mark Scan.  

   The shortcut key is Ctrl-X. 

 

 

Wavewin H.2 - 06/15/2015 

 

1. Date Plotting (Mark and Save): Improved the Mark and Save Sample date window. Below is a list of changes: 

 

   A. Changed the Mark and Save menu option under the Values menu to open the Mark and Save Window. 

   B. Added a Template Section to view the contents of the template and to select the active template  

      from a drop down menu. New Template files can be added to the drop down list by using the Browse  

      button. 

   C. Added a Mark button inside the Mark and Save window to add sample data to the Values window. 

 

2. Device Manager (CMND6): Added the CMND6 variable from the drivers.ini file to get access to each device  

   Save Path. 

 

 

Wavewin H.1 - 06/05/2015 

 

1. ASCII Editor (CR/LF): Added support to read an ASCII file with any combination of the CR LF at the  

   end of a line. 

 

2. Date Plotting (VFT Data): Added a new display driver to read VFT Data files. 

 

3. Data Plotting (Auto Scale ++ Mode): Added a new setting in the properties dialog to switch between  

   Dynamic mode and fixed mode for the ++ Auto Scale. Dynamic scales each channel to the maximum  

   display for each channel. Fixed mode scales each channel to the average value for all  



   displayed channels. 

 

4. Data Plotting (Pick, Mark and Save): Added new fields that can be defined in the Format files.  

   The new fields are: 

 

 <Device> - Writes the Device name in the Values file. 

 <Cycles> - Writes the the number of cycles from the fault bar to the data bar in the  

                   Values file. 

 <DeltaX> - Writes the the Deltax value from the fault bar to the data bar in the  

                   Values file. 

 

5. Data Plotting (Pick, Mark and Save): Corrected a data type problem when writing the date and time  

   at the cursor position to the Values file. 

 

6. Device Manager (RXSAVE): Added a feature to the RXSave command that will append to existing files.  

   Previous versions always over wrote the existing file. 

 

7. Device Manager (RXSAVECRC): Added a new RXSAVE command called RXSAVECRC. This new command will  

   compute the CRC for an entire file and add the CRC value to the name of the file. This new command  

   always overwrites the existing file. 

  

 

Wavewin G.Z - 05/05/2015 

 

1. Data Plotting (Phasors): Updated the phasor scaling after isolating channels in a view.  

 

2. Data Plotting (Double Ended Fault Location): Added Fault Resistence to the double ended calculator.  

   Also added the ability to select the units for the line length. 

 

3. Data Plotting (Comtrade Driver): Added support to default the Scale Factor and B factor inside the CFG  

   file if there is no value defined. A message box is displayed indicating that the values have been  

   defaulted. 

 

4. Data Plotting (Single Ended FL): Added a check that prevents a division by zero when the the Z1 and Z0  

   angles are set to 0. 

 

5. Device Manager (Import Devices): Optimized for faster performance when importing devices in overwrite  

   mode. 

 

6. Device Manager (Dynamic Import): Added checks for the following: ignore Device's to be deleted if they  

   do not exist, report if a device number is out of range (1..2000) or invalid.  

 

7. File Manager (ASCII Editor): Increased the buffer to support line lengths greater then 1024 characters. 

 

 



Wavewin G.Y - 04/16/2015 

 

1. Device Manager (Change Device Passwords): Added 7 Level Passwords to the Change Device Password Dialog. 

 

2. Device Manager (Encrypted Device Passwords): Moved the Change Device Password using an Encrypted file  

   from the Change Device Passwords dialog to a menu option under the Change Device Password menu option  

   under the Device Manager Option menu.  

 

3. Device Manager (Memory Optimization): Removed memory for obsolete commands, RXSTART, TXLOGON, TXEND  

   and TXSTART. Dynamically cleared the data space of all drivers. Data space is only loaded when the  

   driver is running. Move to an inheritance based system from a instance based system. 

 

4. Device Manager (Drivers.ini Path and Name): Added a new field in the Save and Archive (Properties)  

   dialog to specify the path and name of the Drivers file to use when polling the devices. 

 

5. Device Manager (Terminal Mode Logging): Log terminal mode commands if their length is greater then or  

   equal to 1 character. This eliminates logging CR with no text. Cleared the buffer after each command  

   is logged. 

 

6. Device Manager (CR and LF in Files): Removed Carriage Returns and Line Feeds from lines that have more  

   than 1024 characters.   

 

7. File Manager (ASCII Editor): Added support to read the tab ($09) command in the ASCII editor. 

 

 

Wavewin G.W - 02/23/2015 

 

1. Data Plotting (Double Ended Fault Location): Added a graphical interface to show the fault location 

   on the line from both the near and far ends of the line. 

 

2. Data Plotting (Double Ended Fault Location): Create a text file report when the fault location is  

   calculated. The report file is saved to the Wavewin path and is called WAVEDEFL.DTB. 

 

3. Data Plotting (SAC H=0): Added support to plot the DC Offset of a channel using the SACs. Example  

   to plot the DC Offset of Channel 3 enter +3/H=0/u=Amps/ or +3H=0/u=Amps/ in the Channels Operators  

   field. 

 

4. Data Plotting (Append Open Files): Corrected a problem when Appending Open Data Files. The process  

   of copying the existing data plotting variables to the new appended window was causing an exception  

   error. 

 

 

Wavewin G.V - 01/28/2015 

 

1. System (/Comtrade passed parameter): Added a new option to the /Comtrade passed parameter. The  



   /Comtrade=3 option will open the specified event files, select the default view then save only  

   the channels in the default view to a Comtrade 1999 Binary file format.  

 

 

Wavewin G.U - 12/29/2014 

 

1. Device Manager (Auto Configuration): Added support to read the device save path and Communication 

   Processor ID number from the specialized Device import engine. The Communication Processor ID is 

   saved in the CMND7 field in the Command field and the save path is saved in CMND6. 

 

2. Device Manager (CMND 7): Added a CMND7 field to hold the Communication Processor ID number. CMND7 is 

   saved in the Device's command field. 

 

3. Data Plotting (SACs in Views): Added support to save SAC channel names and operators in a User  

   defined view. The SAC operator is saved next to the Channels name surrounded by brackets. 

 

              20,Add Channels 1 2 3[+1/+2/+3/u=A/] 

              21,Add Channels 5 6 7[+5/+6/+7/u=V/] 

 

   The SAC channels are calculated when the view is selected. 

 

4. Data Plotting (Open View Automatically): Added an option to have a default view automatically  

   displayed when a specific file type is opened. To create a default view open the desired event file, 

   select the analog and digital channels for the view and press enter to show only the selected  

   channels. Next select the Save View menu option under the View menu. Enter the path where the 

   event is located. The View's file name is automatically defaulted to the extension of the displayed 

   file (keep the default name). Click OK to save the view. Close the data plotting window. In the  

   file manager select the Display menu option under the Options menu. Select yes for the Open View 

   field under the Data Plotting settings section. Click OK to save. Open one of the event files that 

   has the same extension as the view's filename. The view is saved with the .VIW extension. 

 

5. System (/Comtrade passed parameter): Added a new option to the /Comtrade passed parameter.  

   The /Comtrade=2 option will open the specified event files, select the default view then save only  

   the channels in the default view to a Comtrade file. The Comtrade file is in the 1991 ASCII format  

   and is saved to the same path where the event file is located and named using the same name as  

   the event file.  

 

 

Wavewin G.T - 11/11/2014 

 

1. Device Manager (Close Gracefully): Added support to trap the WM_Close message sent to Wavewin when the  

   program is shut down by Always Up when running as a service. 

 

 

Wavewin G.S - 10/22/2014 



 

1. Device Manager (FTP Save Path): Increased the saved path for the FTP extract files from 80 characters  

   to 255. 

 

2. Data Plotting (Save As Comtrade): Corrected a problem with Saving RMS calibrated data values when the  

   "Convert RMS calibrated date to peak type is set to yes. The conversion during saving to Comtrade will 

   be applied in the data plotting window only and the data type must be set to RMS Type. 

 

 

Wavewin G.R - 09/03/2014 

 

1. Data Plotting (Harmonics Window): Display the percentage of DC Offset in a channel as Harmonic 0.  

   Harmonic 0 is displayed as the first harmonic in the table and in the histogram view. 

 

2. Data Plotting (Reference Vector): Added a new menu option under the View menu to display the phasor 

   vector at the Reference Bar to measure Neutral Shifts. The new menu option is called Reference Vector. 

   The new menu is an On/Off feature defined by a check next to the menu option. Checked equals display 

   vector and unchecked hides the vector. 

 

3. Data Plotting (LPG and R Line Groups): Added support to read the channel colors from the line groups  

   defined in the Comtrade .DAT file corresponding .LPG files and from the R***.inf files. 

 

4. Data Plotting (Set Data Bar): Added a new menu option under the View menu to automatically set the Data 

   Bar position to 2 cycles from the Fault bar. If this option is turned on the data bar is automatically 

   positioned 2 cycles from the fault bar when opening files. The new menu option is called Auto Set Data  

   Bar. The new menu is an On/Off feature defined by a check next to the menu option. Checked equals  

   automatically set the data bar to 2 cycles from the fault bar and unchecked sets the data bar one cycle  

   from the first sample. 

 

5. Data Plotting (Single Ended FL): Added support to automatically fill in the V,I and N channels drop 

   down list from the first 3 marked channels in the active data plotting window. 

 

6. Data Plotting (Double Ended FL): Added support to automatically reference Va as the referenced channel 

   for both near end and far end windows if no analog channels are marked in the displayed windows.   

 

 

Wavewin G.Q - 08/04/2014 

 

1. Data Plotting (Scale by Units): Added a new Auto Scale mode to Scale channels according to the  

   channel units. Current channels are scaled with respect to each other and Voltage channels 

   are scaled with respect to each other. 

 

2. Data Plotting (Super Impose): Added support to have multiple super imposes in the analog channel 

   plot screen. 

 



3. Data Plotting (Plot Single Ended FL): Added support to plot the Single Ended Fault Location in the  

   Data Plotting window. A new button was added to the Single Ended Radial and Reactance tabs to 

   plot the FL for the whole record or between bars. 

 

4. Data Plotting (Plot Double Ended FL): Added support to plot the Double Ended Fault Location in the  

   Data Plotting window. A new button was added to the Double Ended dialog to plot the FL for the whole  

   record or between bars. 

 

 

Wavewin G.P - 07/20/2014 

 

1. Data Plotting (Scale Table Column): Added support to increase or decrease the Scale column value 

   when a channels Amplitude is increased or decreased. 

 

 

Wavewin G.M - 04/10/2014 

 

1. Data Plotting (Fast SAC): Corected a problem with the + and - sequence equations being flipped. 

 

 

Wavewin G.3 - 03/25/2013 

 

1. Data Plotting (Y Scaling): Changed the PixDisp column to display the number of Volts or Amps per inch 

   in the current view/print according to the number of pixels per inch of the screen or printer.   

 

 

Wavewin F.Z - 02/07/2013 

 

1. Data Plotting (Comtrade 2013): Added support to read the new Comtrade 2013 format. Also added the save  

   as Comtrade to support the Comtrade 2013 format.  

 

 

Wavewin F.Y - 01/14/2013 

 

1. File Manager (Passed File Parameter): When a file is passed as a passed parameter to Wavewin it use to 

   first open the file manager then open the passed file. It now just directly opens the file. Directories 

   that have thousands of file takes allot of time to load. This version speeds up the display of  

   passed files.  

 

2. Data Plotting (Drag and Drop Analog Channels): Added the ability to drag and drop mark analog channels 

   to a new position in the analog trace section. 

 

 

Wavewin F.X - 12/17/2012 

 



1. File Manager (Append Logs): Modified the append logs engine to sort the marked logs file according 

   to the fault date and time. In previous version is was sorting them by save date and time. 

 

 

Wavewin F.W - 11/28/2012 

 

1. Data Plotting (Bitronics RAW Files): Added a display driver to plot the Bitronics RAW Trend files. 

 

 

Wavewin F.T - 10/10/2012 

 

1. File Manager (Networked Drives): Improved the reading of the drive letter from the network drive 

   name. In previous versions the network drive was read from the information between the last ( ) 

   symbols in the string. In some cases the information between last ( ) symbols is not the network  

   drive. It now looks for the ':' between the ( ). If not found then go to the next () symbols. 

 

2. Data Plotting (Mark & Save): Corrected a problem with the mark and save not reading the selected 

   format file correctly from the menu option.  

 

 

Wavewin F.Q - 08/20/2012 

 

1. File Manager (User Shortcuts): Added user defined shortcuts to menu options in the File Manager 

   and Data Plotting windows. To define shortcuts open the the File Manager's Display dialog (located 

   under the Options menu). Click the Shortcuts button. Two tabs are displayed below the dialog  

   definition "File Table" and "Data Plotting". To add shortcuts click the menu options under the  

   "Actions" list and click the Move button (green arrow). Shortcuts can be deleted, moved up and  

   moved down in the list. A drop down menu button is displayed in the button menu bar with the  

   selected shortcuts. 

 

 

Wavewin F.P - 08/03/2012 

 

1. Data Plotting (Fast SACs): Added support to add new SAC header and operators to the Fast SAC file 

   by the users. The Fast SAC file (SacList.FMT) is not included with the downloaded zip file. When  

   the system is ran Wavewin will look for the SacList.FMT file if it is found it will read and bin 

   the contents into memory. If it is not found it will create it with the 16 default SAC header and  

   operators.  

 

2. Data Plotting (Save As Comtrade): Added support to clean all illegal filename characters, carriage 

   return and line feeds from the station and device names before saving to Comtrade using the IEEE 

   long file naming format. In previous versions the Emax station information read from the Emax CTL file 

   contained carriage returns and was causing a problem saving the files as Comtrade. 

 

3. Windows 7 (Dialogs): Adjusted the dialog sizes to accommodate the screen size. If a dialog is  



   larger than the screen then scroll bars are displayed to scroll through the dialog. Also, 

   automatically size the dialog according to the dialog fields and not as default values. 

 

4. Windows 7 (ASCII Editor): Adjusted the ASCII text marking to mark the text with reference to the  

   font character width and not the default width. Some Windows 7 systems have character sizes that 

   are different from the defined default width.  

 

5. Windows 7 (Date and Time Blinking): Minimized the date and time blinking in the systems main menu 

   bar by turing off the Transparent field. 

 

 

Wavewin F.N - 06/04/2012 

 

1. Data Plotting (Fast SACs): Added a drop down list to the SACs operator fields. The drop down list 

   allows for selecting predefined Fast SACs. The position of the channel number is replaced with 

   a pound sign #. If there are marked channels in the data plotting window then the pound sign is  

   replaced with the marked channels number. If no channels are marked the user will have to replace 

   the pound sign with the desired channel numbers. To have the Fast SAC header automatically copied 

   to the SAC title fields click on the check box located at the bottom of the Fast SAC drop down list. 

 

Wavewin F.F - 10/10/2011 

 

1. Data Plotting (Reference Angles Across Windows): Allow for referencing angles across open windows when 

   not in Sync mode. In previous versions it was required to have sync mode on to see angles referenced  

   across windows. To reference angles across windows open the Windows Properties dialog click on the  

   "Display Settings" tab. The last field on this tab allows for activating referenced angles across  

   windows. 

 

 

Wavewin F.D - 07/05/2011 

 

1. File Manager (Default Path): Added support to define the default path the file manager will always 

   open in. To define the file manager's default path, select the "Display" menu option under the  

   "Options" menu. Enter or browse to select the desired path in the "Default Path" field. When the  

   file manager is opened it will attempt to display the folders and files in the default path, if  

   it cannot connect to the default path then the Wavewin path is displayed. 

 

2. Data Plotting (Sequence Calculator): Added the display of the phasor chart to the sequence calculator. 

   Also, added support to display the sequence calculator for a single end or if two files are open 

   display the sequence calculator for both end to end files. Also, added the selection drop down lists 

   to define the channels for VA, VB, VC, IA, IB and IC. 

 

3. Data Plotting (Fault Calculator: Double Ended): Simplified the Double End Fault Calculator. The new  

   Double Ended Calculator displays the input fields: Z1 (Mag and Angle) and the Line Length on the left 

   side of the window and the Fault location Output fields (Zero Sequence - FL0, Positive Sequence -  



   FL1, Negative Sequence - FL2) in the middle of the window. To display more details such as the data  

   values, the channels for VA, VB, VC, IA, IB and IC and the sequence components magnitude and angles  

   click on the "Show Details" button. 

 

 

Wavewin F.C - 06/12/2011 

 

1. Data Plotting (Merge Open Files): Corrected a scale factor conversion when merging open files that have 

   been converted from the original values to primary or secondary quantities. 

 

2. Data Plotting (Save As): Corrected a typo in the Save As menu under the CSV menu. 

 

 

Wavewin F.A - 04/10/2011 

 

1. Data Plotting (Digital Channel Original State): Added the default view to view all digital channels  

   when there are no original state values defined in the Comtrade CFG file. Also, set the digital   

   channel state at the cursor position to a red "D" in the digital channel table to define that the  

   channels original states where defaulted to 0. 

 

2. Data Plotting (Analog Channel Zero Axis Dotted Line): Corrected a problem when plotting the zero  

   x-axis dotted line. The previous version was plotting the zero x-axis as a solid line when in  

   a compressed view. 

 

3. Data Plotting (Under and Over Triggers in SACs): Modified the way the under and over trigger checking 

   is performed in the SACs. 

 

 

Wavewin E.Y - 12/07/2010 

 

1. File Manager (Move Files): Added the ability to drag and drop files into the folder tree for moving  

   files to a new folder. Mark the files to move in the file table then drag them to the desired folder  

   displayed in the folder tree.  

 

 

Wavewin E.V - 08/23/2010 

 

1. System (Passed Parameter): Added a new passed parameter to automatically convert a file to the  

   IEEE C37.111 Comtrade ASCII 1999 format. The new passed parameter is /Comtrade. To retain the  

   original file name of the source file use the /Comtrade passed parameter. To have the file  

   automatically named using the IEEE C37.232 file naming format use the /Comtrade=1 passed  

   parameter. The /Comtrade command line parameter can also be used in batch files. The converted  

   Comtrade files are saved in the same directory as the source file. The new passed parameter will  

   convert the source file to Comtrade then display the converted Comtrade file in the data plotting  

   window. 



 

   Below are some examples: 

  

 Examples: 

 --------- 

 

 1.) Passed Parameter:  "c:\faultlib\shipdir\SEL-421.CEV" /Comtrade=1   

            Comtrade Filename: 011207,145119291000,-5,Station A,Relay 1,SOFTSTUF, 

                               TRIP,,SOTF B_PHASE C_PHASE GROUND 50,60.00.DAT 

 2.) Passed Parameter:  "c:\faultlib\shipdir\DATA1068.RCD" /Comtrade 

            Comtrade Filename: c:\faultlib\shipdir\DATA1068.DAT 

 

 

Wavewin E.U - 08/17/2010 

 

1. Data Plotting (Save Sample Values): Added a new menu option to the "Save As CVS" option. The new option 

   will Save the Vector values in RMS and Angle. The four Save As options are now: 

 1.) Save As CSV - RMS Values: Save the RMS Values in a comma delimited format. 

 2.) Save As CSV - Instantaneous Values: Save the Instantaneous Values in a comma delimited format. 

 3.) Save As CSV - Vector Values (Mag & Ang): Save the DFT Magnitude and Angle in a comma delimited format. 

 4.) Save As CSV - Vector Values (RMS & Ang): Save the RMS Value and Angle in a comma delimited format. 

 

2. Data Plotting (Harmonics): Increased the number of harmonics displayed from Samples/Cycle div 2 to the 

   number of Samples/Cycle. Allows to see the mirror image of nyquist harmonics. 

 

 

Wavewin E.T - 08/05/2010 

 

1. Data Plotting (Save Sample Values): Added a new menu option "Save As" to the "File" menu. There are 

   two sub-menus under the "Save As" option: "Comtrade" and "CSV Format". The "Comtrade" option saves the 

   displayed channels in either the ASCII or Binary format. The "CSV Format" will save the RMS, Instantaneous 

   or Vector (Magnitude and Angle) values to comma delimited text file. The first line in the CSV file 

   is the header information for each channel. All the analog channels that can be displayed in the active 

   data plotting are saved. A dialog box is displayed to enter the destination path and the filename. The 

   destination path is automatically defaulted to the active path in the file manager. The filename can be  

   directly entered into the "File Name" field or the file can be automatically named using the IEEE long 

   file naming format. To have the file automatically named click on the "ComNames" check box. If the 

   "ComNames" check box is checked then the File Name field will be disabled. To enter a file name make  

   sure the "ComNames" check box is unchecked. 

 

 

Wavewin E.R - 06/27/2010 

 

1. Data Plotting (Sequence Calculator): Added a Sequence Components calculator. The sequence calculator works off 

   the active (highlighted) data plotting record. The channels in the active record must be organized as follows:  



   The first 3 visible channels are the Voltage channels, VA, VB and VC. The next 3 visible channels are the  

   Current channels, IA, IB and IC. To reposition the analog channels first mark the channels then use the plus  

   key to move the channels up one position and the minus key to move the channels down one position.  

   The values populated in the dialog are read at the data bar position in the active record. The sequence  

   calculator dialog is a stay on top window. This allows for repositioning the data bars without closing the  

   dialog. To refresh the Voltage and Current values in the dialog use the Refresh button. Use the Calculate 

button  

   to calculate the sequence components. 

   To increment the voltage and current angles enter an increment value in the Angle Rotation fields and click  

   on the Rotate button. 

   To open the sequence calculator dialog select the "Sequence Calculator" menu option under the "Data" menu.   

 

2. Data Plotting (Primary/Secondary Ratios): Added the abilty to change the primary and secondary ratio values for 

   the analog channels in the open record. To change the ratio values open the "Window's Properties" dialog by  

   selecting the "Window's Properties" menu option under the "File" menu. Click on the "Driver Data Type" tab then 

   click on the "Edit Ratio Values" button under the "Analog Values" section. In the Ratio Values dialog move the 

   cursor to the specific Primary/Secondary values and change the displayed value. To apply the modified ratios  

   click on the "OK" button. The modified ratio values are Not saved to the original file on disk. To save the 

ratios 

   values to disk use the "Save As Comtrade" option listed under the "File" menu.   

 

3. Data Plotting (Peak/RMS Type): All analog channels displayed are viewed as Peak type. To change the type of  

   values displayed, open the "Window's Properties" dialog by selecting the "Window's Properties" menu option 

under  

   the "File" menu. Click on the "Driver Data Type" tab then select the Data Multiplier type from the drop down 

   list under the Analog Data Type section. To always have the driver specific files displayed as RMS type  

   (Root 2 Multiplier) open the "Driver Configuration" dialog from the File Manager's "Option" menu. The  

   Driver Configuration dialog lists all display drivers supported, click on the driver in the "Drivers" list 

   then change the Driver's Data Type to RMS calibrated.   

 

4. Data Plotting (Data Cursors): Corrected a problem with displaying the data bar in non-active data windows. 

 

 

Wavewin E.L - 04/26/2010 

 

1. System Tables (Mark Files): Removed the new single click marking. This feature is now an option in the 

"Display" 

   dialog. The default is the Window's marking convention. To set the marking/unmarking using a single mouse click 

   open the "Display" dialog under the table's option menu and select "Single Mark Click" in the "File Marking"  

   drop down list. 

 

 

Wavewin E.J - 04/21/2010 

 

1. System Tables (Mark Files): Changed the way files are marked in the system tables. A single click on a row  



   will mark the row. To unmark the row click on the row again. The single click now works as a toggle between  

   marked and unmarked. 

 

 

Wavewin E.H - 04/14/2010 

 

1. Data Plotting (Print Profile): Added the ability to save a print profile file when saving a view file. The  

   print profile fields where added to the "Save View" dialog. The "Save View" dialog is a menu option under the  

   "View" menu. The "Save View" dialog now has the ability to manipulate the channels in the view and to specify  

   the print orientation and the type of ASCII Summary information to print Short=General Information,  

   Advanced=General Information plus Channel Information. 

 

 

Wavewin E.F - 01/14/2010 

 

1. System (System): Allow strings with 10 characters to be converted to an integer value. In previous version  

   the conversion to integer allowed only 9 character strings. 

 

 

Wavewin E.E - 12/22/2009 

 

1. Data Plotting (International Date Time): Added support to handle international date and time settings in the  

   Window's Regional and Language settings. Previous versions where using the US date and time settings which  

   was causing problems converting the date and time stored in some files. 

 

 

Wavewin E.D - 12/10/2009 

 

1. System (Data Plotting Print): Added support to print a file using a specific user defined view via the  

   command line parameters. To print a view use the /PROFILE= "File path and name" along with the /PRINT command  

   line parameter. Example: 

   "c:\faultlib\comtrade\DR1_0006.DAT" /Print /Profile= "c:\faultlib\comtrade\Average Channels-D.VIWD"  

 

 

Wavewin E.C - 11/30/2009 

 

1. Data Plotting (Phasors): Added support to display the phasors using a common convention for showing polarity. 

 

 

Wavewin E.7 - 10/12/2009 

 

1. Data Plotting (SACs): Added 2 new SAC operators: "s" (Sin) & "c" (Cos). The "s" operator is used to compute the  

   sin "c" is cos. These two new operators allow for calculating Power factor, Actve and Reactive Power. Refer to  

   the SAC help window for application examples. 

 



2. Data Plotting (Harmonics): Added a white background behind the harmonic values in the histogram display. This 

   make the numbers more readable. 

 

 

Wavewin E.6 - 09/28/2009 

 

1. Data Plotting (Change Frequency): Added support for Changing the Frequency for Comtrade files that have a zero 

   defined as the Sampling Rate. The change frequency engine calculates the fractional difference between the 

   old frequency and new frequency once before performing the change frequency for each sample. Added the 

fractional 

   difference for each sample. 

 

2. Data Plotting (Primary/Secondary): Added resizing to the analog table column's width when changing the type of 

data 

   displayed, primary and secondary. 

 

3. Data Plotting (Save As Comtrade): Corrected a problem Saving a File As Comtrade from the data window when the 

File 

   Manager table is closed. The Save As Comtrade engine was trying to access the File Manager's translate strings. 

 

4. Data Plotting (Phase Angles): Added an option to toggle between showing the Cos Convention (0 Deg at Positive 

Peak) 

   and the Sin Convention (0 Deg at Zero Crossing) for the phase angles. The new option is in the Window 

Properties  

  dialog under the Display Settings tab. 

 

 

Wavewin D.Z - 06/12/2009 

 

1. Data Plotting (Syncrophasor Support): Modified the phasor displays to follow the syncrophasor convention  

   (+Peak=0 Degrees).  

 

2. Data Plotting (SACS): Added a set of fast recursive engines for calculating RMS, Phase, Magnitude, Real,  

   Imaginary and frequency components for each channel.  

 

3. Data Plotting (SACS): Added 8 new SAC operators using the values calculated from the recursive engines.  

   The new SACS operators are: 

 

 "x": real component 

   "y": imaginary component 

   "m": magnitude 

   "d": angle 

   "r": true rms 

   "f": cyclic frequency 

   "q": instantaneous frequency 



   "t": delta time frequency 

 

4. Data Plotting (SACS): Added a number of examples in the SAC help window describing how to use the new  

   and existing operators. 

 

5. Data Plotting (Time Discontinuity): Added a new engine to detect discontinuities in time. If a time 

discontinuity 

   is encountered then a green dotted line is displayed at the sample where the discontinuity occured. A mouse 

over  

   the small gray triangle displayed at the bottom of the green line will show the duration. To turn off this 

feature  

   set the "Show Event Separator Bars" field to "No" (in the properties dialog). 

 

6. Data Plotting (Harmonics): Changed the displayed Total Harmonic Distortion value from RMS to Instantaneous  

   (for compliance with IEEE notation). 

 

7. Data Plotting (Summary): Revised the Summary Window to show: Max, Min & Max Min Difference for both 

Instantaneous 

   and RMS values. 

 

8. Data Plotting (Navigate Peaks): Revised navigate peaks to navigate the DFT peaks instead of the instantaneous 

   peaks. 

 

9. Data Plotting (Print): Added the time line and ruler to the print engines. 

 

10. Data Plotting (Append): Corrected a problem appending log files. The time difference between the selected 

append  

    files was being calculated to the microsecond. It is now calculating the difference according to seconds. 

 

 

Wavewin D.N - 06/24/2008 

 

1. File Manager (Show/Hide Channel Titles): Added a new dialog to give the ability to show/hide analog and digital 

   channels via the channel title. To open the dialog select the "Show/Hide Channel Titles" option under the  

   "Options" menu. All titles listed that have a check in the checkbox are automatically hidden when the file is  

   displayed. To show the title uncheck the checkbox next to the title. To remove a title from the list use the  

   "Remove" button. To add a new title type the new title in the edit box and click the "Add" button. The new  

   title is automatically added to the end of the list and the checkbox is defaulted to checked. 

 

 

Wavewin D.M - 06/12/2008 

 

1. Data Plotting (Print Window): Added a new print option to print the contents of the window. The new option  

   is called "Window" and is located under the "Print" submenu. 

 



2. Data Plotting (Print All & Page): Corrected a problem printing the analog table. The columns where being  

   resized improperly. 

 

 

Wavewin D.L - 06/11/2008 

 

1. Data Plotting (User Views): Added a new feature to automatically open all user views in a separate window when  

   a request is made to open a data plotting file. A maximum of 10 views/windows can be displayed at one time. 

 

 

Wavewin D.K - 05/29/2008 

 

1. Data Plotting (Print): Included the Waveform Summary as part of the data plotting print. 

 

2. Data Plotting (Analog Table): Added automatic column sizing according to the largest max & min values. Previous 

   versions were using a fixed size which was causing values to overlap into neighboring columns. 

 

 

Wavewin D.H - 04/02/2008 

 

1. Data Plotting (User Views): Improved the user views by allocating seperate extensions for each type of file. 

   WR files have a ".VIW" extension, DR files have a ".VIWD" extension and TR files have a ".VIWT" extension. The  

   extension is automatically added to the view filename when saving the view. 

 

2. Data Plotting (User Views): Defaulted the save view and select view directory to be the directory where the  

   currently displayed file is located. The default directory will change when the user either selects a different 

   directory in Save View dialog or if the directory is changed in the Select View dialog.  

 

 

Wavewin D.C - 01/21/2008 

 

1. Data Plotting (User Views): Improved the user views by including the following information in the view:  

   sampling frequency, time scale, sliding window size, phasor window size, table window size, red fault bar, 

   auto scale and phasor or circular chart displayed.  

 

 

Wavewin D.C - 01/03/2008 

 

1. Data Plotting (Digital Channels):  Inrcreased the number of digital channel title characters displayed from  

   40 to 80.  

 

 

Wavewin D.B - 12/13/2007 

 

1. Data Plotting: Added the trigger information from the 1st line in the Comtrade HDR file to the data plotting  



   window in the Phasor display section. The TRIGGER= is no longer needed to be defined. If TRIGGER= exists then  

   TRIGGER= will be deleted. 

 

 

Wavewin D.A - 12/03/2007 

 

1. Data Plotting: Added the trigger information from the 1st line in the Comtrade HDR file to the data plotting  

   window in the Phasor display section. The trigger information is displayed if there is TRIGGER= on the first 

   line in the HDR file. 

 

 

Wavewin D.9 - 11/05/2007 

 

1. Data Plotting (Save Views): Added a new option to save analog and digital channel views to an ASCII text file.  

   To save a view mark the desired analog and digital channels and press <enter>. Select the "Save View" menu  

   option under the "View" menu. Enter the views filename and path and press enter. The saved view will be added  

   to the views drop down list on the menu button bar. The views drop down menu list displays the last 15 saved  

   or selected views. 

 

2. Data Plotting (Select Views): Added a new option to select saved views. To display a saved view select the view 

   file from the "Views" drop down list displayed in the menu button bar. If the desired view is not displayed in 

the 

   drop down menu list select more views to navigate to the saved view. Views can also be selected using the  

   "Select Views" menu option under the "View" menu. The "Select Views" dialog list all the view files in the 

active 

   view path. To change the view path select a path from the "View Path:" drop down list or use the browse button 

   to select a new path. The analog and digital table displays the properties of the selected view. 

 

 

Wavewin D.4 - 09/09/2007 

 

1. Data Plotting: Fixed a problem with the Primary and Secondary values not being added to the Comtrade files 

created 

   during a command line merge operation. The primary and secondary values are now added to the Comtrade .CFG 

files. 

 

2. File Manager: Fixed a problem in the file tree when directory names are 1 character only. Previous version were 

   causing a access violation error when a directory was 1 character in length. 

 

3. Data Plotting: Corrected a problem when using the command line to merge trend files.  

 

4. Data Plotting: Fixed a problem with updating the file's date and time in the window's header when the automatic 

   Adjust Files Time is implemented. The files time was adjusted after the window's header was updated. 

 

5. Data Plotting: Upgraded all of the time calculations from the old 32 bit, integer infrastructure to a  



   new 64 bit, floating point structure. This upgrade has eliminated the errors that were caused by accumulated 

   truncations. 

 

 

Wavewin C.V - 03/29/2007 

 

1. System: Added support to always save the Comtrade file in the 1999 format for merge via the command line 

   parameters. 

 

 

Wavewin C.T - 03/23/2007 

 

1. System: Added support to merge files via the command line parameters. 

 

2. System: Added support for more then 4 languages. Increased the number of languages to 20. 

 

 

Wavewin C.S - 03/12/2007 

 

1. Data Plotting: Finialized the fault location dialog. 

 

 

Wavewin C.R - 02/27/2007 

 

1.  System: Did more work on resizing more of the dialogs and windows to handle the Microsoft Monitor 120 DPI 

setting. 

 

2.  System: Added the advanced captions, hint and strings to the translation files. 

 

 

Wavewin C.Q - 02/02/2007 

 

1.  Fault Location: Rearranged the fault location dialog according to Pete Vivers email dated 01/24/2007. Added an  

    Advanced button to allow users to change the Phase Selection mode and for editing the Z1 and Z2 % of line, R0 

and  

    Rg division factors and the threshold fields. 

 

2.  Fault location: Added the automatic display of the change frequency dialog box when the file's current 

sampling 

    frequency is not set to 24 samples/cycle. 

 

3.  Data Plotting: Fixed an error in the change frequency engine when changing from a high frequency to a low 

    frequency. The previous algorithm was not taken the fraction portion of the difference between the old and 

    new frequencies. This has been corrected and is now working. 

 



4.  Data Plotting: Added support to handle the comma as a decimal separator in the fault location dialog and in 

the 

    change frequency dialog.   

 

 

Wavewin C.P - 01/22/2007 

 

1.  System: Added resizing to a number of dialogs and windows to handle the Microsoft Monitor 120 DPI setting.   

 

 

Wavewin C.O - 01/07/2007 

 

1.  Data Plotting: Fixed a problem with calculating the total number of samples sent to the 

    SingleEndFaultLocation.dll. The previous version was using the fault trigger position defined in the Comtrade 

CFG  

    file to calculate the total number of samples to send to the DLL. This problem has been corrected, it now uses 

the  

    reference bar position to calculate the total samples. 

 

2.  Data Plotting: Included all Fault location message strings to the SIL & SIB files. 

 

3.  Data Plotting: Added a call to Get Last Error for all function calls in the fault location dialog. Also 

increased 

    the length of the output fields to fit the Fault time information. 

 

4.  Data Plotting: Changed the fault reference position to the Reference bar (blue dotted line). This allows the 

user 

    to change the fault position by right clicking in the trace window. 

 

5.  Data Plotting: Added a print button to screen dump the contents of the fault location dialog. 

  

 

Wavewin C.N - 12/20/2006 

 

1.  Data Plotting: Added a Fault Location dialog to interface to Areva's fault location DLL  

    (SingleEndFaultLocation.dll). To open the new dialog select the Fault Location menu option under the Data 

menu.  

    Before opening change the sampling frequency to insure 24 samples per cycle. Enter all of the Input fields in 

    secondary quantities. An error message will be displayed if there is a problem with the input settings. Select  

    the proper channels in the Analog Channel section then press the Start button. The results will be displayed 

in 

    Output section. Any errors or warnings will be displayed in the Errors & Warning text box. The fault location  

    dialog sends all samples values in secondary quantities. The number of samples sent depends on the values 

defined 

    in the pre and post reference bar fields in the Analog Channels section. The start sample and the number of 



    samples sent is displayed in the status bar.  

 

2.  Data Plotting: Added support to read Comtrade ASCII *.DAT files that include blanks between the data values 

and 

    the comma separator. The complier method used for converting the string to interger values was returning an  

    error because of the included blanks. Added support to delete all blanks before converting the string to an 

    integer. 

 

3.  Data Plotting (Properties Dialog): Added a new button in the "Windows Properties" dialog under the  

    "Driver Data Type" tab. The "Analog Values" section allows for viewing each channels Primary & Secondary ratio 

    values. Click on the "View Ratio Values" button to display all of the analog channels Primary & Seconday 

values. 

 

 

Wavewin Areva C.J - 08/04/2006 

 

1.  Data Plotting: Added a new selection option to switch between Primary and Secondary values. The following 

drivers 

    supply the CT and PT ratio values in the files to perform the calculation from Primary to Secondary and from  

    Secondary to Primary: Comtrade, Transcan DFR, Faxtrax/Director DFRs, SEL Relays & DLP Relays. To change the  

    analog values open the Windows Properties dialog by clicking on the "P" menu button, or select the  

    "Window Properties" menu option from the "File" menu. Click on the "Driver Data Type" tab and select Primary 

    or Secondary from the "Analog Values" section then press <Enter> or click OK. The type of analog values 

displayed 

    is defined in the Data Plotting's Window header after the Fault Date & Time. 

 

2.  Data Plotting (Printing): Fixed a problem with the print engine. When an ASCII Comtrade text file uses a Line  

    feed (OA) only for the line seperator the Comtrade ASCII read engine was not reading the last sample in the 

file. 

    The number of samples plotted did not equal the total number of samples defined in the Comtrade CFG file.  

    This was causing the print engine to issue an endless number of blank pages because it was never getting to 

the 

    total number of samples defined in the CFG file. 

 

 

Wavewin Areva C.I - 07/10/2006 

 

1.  System: Added support to process Batch files through the passed parameters. The Batch passed paramter must be 

    passed for the batch processing to successfully be implemented. The Batch file can contain file to print and  

    files to view. Wavewin can display a maximum of 10 data plotting windows and a maximum of 10 ASCII text files  

    at one time. When using the Batch command for viewing files have no more than 10 data plotting files and 10  

    ASCII text files specified in the batch file. Below are examples of the contents of batch files: 

 

    Printing: 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Waveform\WR1_000004.dat" /print /exit 



      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Waveform\WR1_000007.dat" /print /exit   

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Waveform\WR1_000009.dat" /print /exit 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Waveform\WV006.dat" /print /exit 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\SOE\084873_2954.txt" /print /exit 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\SOE\162407_2950.txt" /print /exit 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Disturbance\DR1_000003.dat" /print 

/exit 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Disturbance\DR1_0008.dat" /print /exit 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Disturbance\DR1_0009.dat" /print /exit 

       

    Viewing: 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Waveform\WR1_000004.dat"  

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Waveform\WR1_000007.dat"  

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Waveform\WR1_000009.dat"  

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Waveform\WV006.dat"  

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\SOE\162407_2950.txt"  

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Disturbance\DR1_000003.dat"  

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Disturbance\DR1_0010.dat"  

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Trend\TR1_a.DAT"  

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Trend\TR1_b.DAT"  

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Trend\TR1_000001.DAT" 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\Trend\TR1_000002.DAT" 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\SOE\SOE_000001.txt" 

      "c:\program files\Win DR Manager\Storage\M571 - Ied 3  67.137.195.220\SOE\SOE_000007.txt" 

 

2.  Data Plotting (SACs): Added more protection to avoid Access Violation Errors when improper information 

    is entered in the operator fields. 

 

3.  File Manager: Fixed a problem when trying to access directories using networked computer names:  

    \\other machine\fault files. 

 

 

Wavewin Areva C.H - 06/15/2006 

 

1.  Data Plotting: Fixed a problem with the F9 function key for files with digital channels only. Made available 

    on the beta page. 

 

2.  Data Plotting (SAC Window): Added 4 new buttons in the SAC window to save / open SAC files.  The new "Save"  

    and "Save As" buttons allow for saving the current SAC information into an ASCII text file.  The new "Open"  

    button allows for reloading previously saved SAC files. The "New" button allows for creating new SAC files. 

 

Wavewin Areva C.G - 05/19/2006 

 

1.  System: Fixed a problem with the /print passed parameter.  In previous versions it was required that  

    the contents of the window be fully painted on screen before the print occurred. When too many prints were  



    issued close together a range check error was generated because the screen information was not fully painted. 

    We modified the print to work with a virtual graphics handle instead of using the window's graphics handle. 

 

2.  File Manager: Corrected a problem with the unzip components used to unzip the .ZAT files. Frederic reported  

    that a message box was displayed from the ZipTV components stating that the components were not registered. 

    We corresponded with ZipTV and have corrected the problem.  The components on Softstuf's development  

    stations were not properly registered. 

 

3.  Data Plotting: Harmonics, added a check to avoid the bar width going under 1. 

 

Wavewin Areva C.F - 04/14/2006 

 

1.  System: Fixed a number of problems and made some changes to the passed parameters: 

       a. Changed the /X1 and /Y1 passed parameters to /X and /Y. There was no need for the 1 indicator since 

          we changed /X2 and /Y2 to /W and /H. 

       b. Fixed a problem with the /Print passed parameters on slower machines. The print function was being 

          called before the paint method for the window. 

       c. Corrected a problem with viewing files. 

       d. Corrected a problem with the /TopMost passed parameter. 

 

2.  Data Plotting: Added an option in the Harmonics window to change the bar size to show as many harmonics 

    as possible in one screen. 

 

3.  Data Plotting: Changed the units for the time bar and Delta X status bar to show time in a readable  

    format. We also added a unit and color indicator according to the time displayed. 

 

Wavewin Areva C.E - 03/22/2006 

 

1.  System: Added more resizing for the dialogs to support the Spanish and German languages. 

 

2.  System: Added Frederics suggestions for passed parameters and also fixed a few problems with the new  

    passed parameters. 

 

3.  Data Plotting: Added a fixed dotted light red fault bar, also added an option in the properties dialog  

    to show or hide the fault bar. 

 

4.  Data Plotting: Added resizing to the harmonics window to view as much information as needed. 

 

 

Wavewin Areva C.D - 02/21/2006 

 

1.  System: Added support to view Wavewin Areva in different languages.  First language added was French.  All  

    remaining languages can be added to the SIL and SIB files without further coding in the software.  Also all 

    menu items have been added to the SIL and SIB files.  To change the active language select the "Display" 

option 



    under the "Options" menu in the File Manager.  Slect the desired language from the "Languages" drop down list. 

 

2.  File Manager: Moved the last active directory to the Wavewin.ini File.  In previous versions the last active  

    directory was saved to the Template database that has a limit of 80 characters.  The Wavewin.ini eliminates  

    the 80 character limit. 

 

3.  Data Display: For files that have digital channels only made sure that all digital channels are displayed if 

there 

    are no triggered channels in the file. 

 

 

Wavewin Areva C.A 11/28/2005 

 

1.  File Manager:  Added sorting to the table folder tree. 

 

2.  File Manager:  Always open Wavewin's folder tree to the last active directory. 

 

3.  Data Plotting: Fixed a problem with the boundary check for Comtrade ASCII digital channels. 

 

4.  Data Plotting: Fixed a problem with calculating the sampling frequency for Comtrade files that define 

    a zero for the sampling frequency. 

 

5.  Data Plotting: Increased the maximum number of harmonics displayed in the harmonics table from 100 to 200. 

 

 

Wavewin Areva C.7 09/12/2005 

 

1.  Data Plotting: Added a histogram view in the harmonics window. Click the change view button in the upper  

    right corner of the window to toggle between the table and the histogram.  The histogram view allows for  

    selecting the column of data to show.  Click on the "Select Bar Values" drop down menu to change the values 

    displayed. The "% of Fundamental" is the default view. 

 

 

Wavewin Areva C.6 - 08/15/2005 

 

1.  Data Plotting: Improved the Harmonics window to display the number of harmonics according to the number of 

samples 

    per cycle for the open file. 

 

2.  Data Plotting: Fixed a problem wixth the Comtrade read engine.  The last analog channel's data values were not  

    being read therefore the sample values were defaulted to zero.  The Comtrade engine was modified so that a  

    maximum of 255 analog channels can be displayed in the data plotting window.  The maximum analog channel 

boundary  

    was not being checked properly and the last analog channel was not being read. 

 



 

Wavewin Areva C.5 - 08/14/2005 

 

1.  Data Plotting: Added two new columns to the Analog table. DFTMag = Displays the DFT Magnitude calculated 

between 

    the RMS bar (black dotted line) and the data bar (solid data bar).  Crest = Displays the DFTMag column divided 

    by the RMS column. 

 

2.  Data Plotting: Added a new field in the harmonics dialog called "Total Harmonic Distortion".  The "Total 

Harmonic 

    Distortion" field displays the ((sqaure root of the summation of the squares of DFT Magnitudes from harmonics 

    2 to 7) divided by square root of 2) and that quantity divided by the DFT Magnitude of the Fundamental. 

 

3.  File Manager:  Fixed a problem with the status bar fields not updating when navigating via the tree. 

 

4.  File Manager:  Modified the table sort engine to always sort the columns in upper case.  The previous sort 

engine 

    was sorting the column data as is.  This was causing a problem when files are named with upper case and lower 

    case. 

 

5.  Data Plotting: Fixed a problem with reading multiple binary Comtrade files.  The Comtrade binary read multiple 

    files was not reading the files in proper sequence. 

 

6.  Data Plotting (SACS):  Fixed a problem with the SACS returning an error when calculating an Envelope using the 

    "A" and "E" script commands. 

 

7.  Data Plotting:  A number of requests have been made to change the way the expand and condense time displays 

    the waveform signals.  In versions previous to C.3 the expand and condense would display the first sample out 

of 

    the group of samples to condense or expand.  To  better show the peaks we changed that functionality in 

version 

    C.3 to pick the hightest value in the group of samples to condense/expand.  This still did not show all the 

    information. In this version Wavewin now displays all of the samples in the file.  When the signals are  

    condensed the samples are plotted over each other. 

 

8.  Data Plotting:  Added a feature to hop the data bar by one cycle for waveform files and one day for load 

files. 

    This feature is keyboard activated, use the Shift+Ctrl+Right/Left Arrows to move the data bar one cycle/day 

from 

    the previous position. 

 

9.  File Manager:  Added Cut, Copy and Paste to easily move files from one directory to another.  The new Cut, 

Copy 

    and Paste features work in the same fashion as Window's Explorer.  Use the following menu items or short-cut 

keys 



    to activate the added file features: Cut:(Edit Menu: Cut Option, Ctrl+X, Shift+Del), Copy:(Edit Menu: Copy 

Option, 

    Ctrl+C, Ctrl+Ins), Paste:(Edit Menu: Paste Option, Ctrl+V, Shift+Ins). 

 

    Drag and Drop coming soon. 

 

10. File Manager:  Added shortcuts in the file table right click pop-up menu for Cut, Copy and Paste files and for 

    the Zip, Email and Refresh features. 

 

11. File Manager (Save As Comtrade):  Fixed a problem with Save As Comtrade for the 1991 and 1999 formats.  The 

1991 

    format was defining 3 fields (substation,device ID,version #) for the first line in the CFG file. The proper 

    format is substation,version #.  Wavewin now puts the substation - Device ID,version#. For the 1999 format the 

    last line in the CFG file is the time multiplier for the sample times in the .DAT file.  Wavewin was only 

adding 

    the time multiplier field to the CFG if it was greater than 1.  Now it always adds the time multiplier field. 

 

12. File Manager: Fixed a problem with reading the line frequency from the Comtrade ".CFG" file.  The line 

    frequency was always defaulting to 60. 

 

13. File Manager: Fixed a problem with the list of child windows being displayed under the wrong menu item. 

 

14. Data Display:  Added a medium display to the Auto Scale (F6, Atl-D, A) toggle feature.  Auto Scale toggles 

between 

    (Off, On and ++).  ++ plots the signal using the number of maximum pixels allowed for the channel.  The 

highest 

    value is plotted at the maximum position allowed and the smallest value is plotted at the lowest position 

allowed. 

    This feature was added to clearly show the profile of frequency, Vdc and load data channels. 

 

15. Data Display:  Added a new option in the properties dialog under the Comtrade tab called: "Show Date 

    in (US/European/Japan) Format. This new option allows for selecting a fixed date format for the Comtrade 

    files. 

 

16. Data Display:  Fixed a problem with the fault time line when calculating if the time is greater then a k. 

 

17. File Manager: Added a Directory Tree for easy navigation.             

 

18. File Manager (Delete Files): Changed the way the delete files engine works. It will now send files that reside  

    on the computer to the Recycle Bin all others are permanently deleted.      

 

19. File Manager (Rename Files/Folders): To rename a folder in the tree click on the folder name twice  

    to display the edit box. To rename files select the rename option from the Files menu. 

 

20. File Manager:  Added the ability to email marked files directly from the file table.   



    Click on the email menu button to activate.  All support files are automatically attached to the 

    email message. 

 

21. File Manager:  Added the ability to zip marked files directly from the file table.  To activate, open  

    the "File" menu and select "Zip Marked Files" option. All support files are automatically added to the zip 

file 

    upon confirmation. 

 

22. Data Plotting:  Added the ability to email the active event file. All support files  

    are automatically attached to the email message.  To activate, click on the Email menu button. 

 

23. Data Display:  Added "Analog Input" & "External Input" as a non used channel.  Wavewin does not show analog 

    and digital channels that contain the following strings: 

      UNUSE 

      UNDEF 

      NOT D 

      NOT U 

      NOT I 

      NOT A 

      { 

      N/A 

      ANALOG INPUT 

      ANALOG CHANNEL 

      EXTERNAL INPUT 

      EVENT CHANNEL 

      CHANNEL: 

      DIGITAL TRACE # 

      SPARE 

 

24. Data Display: Fixed the data display in the Windows XP display mode.  The last digital channel was being  

    overwritten by the window's border.  Also fixed the sizing of the Wavewin main application window to size  

    around the desk top toolbars. 

 

 

Wavewin Areva B.X - 01/24/2005 

 

1.  Data Plotting: Increased the number of analog channels per window from 128 to 256. 

 

2.  Data Plotting (Load Files):  Added a new column "AvgWin" to the Analog Table located between the traces  

    and the circular chart.  The "AvgWin" column averages all the sample values between the RMS bar (black 

    dotted vertical bar) and the data bar (black solid verical bar). 

 

3.  Data Plotting: Added a new option to resize the RMS sliding window (area between the black dotted vertical bar  

    and the black solid bar).  The size of the sliding window can be changed by clicking on the resize sliding 

    window menu speed button to bring up a dialog or by selecting a fixed number from the drop down menu list. 



    The window in Load files is changed according to hours or days and in transient files according to cycles. 

    To bring up the resize dialog from the menu select the "View" menu then select the "Set Sliding Window" 

option. 

 

4.  System Speed Bar Menu: Added a new "Back" button to go back to the previous window.  

 

5.  File Manager: Added a new feature to save summary files.  The "Waveform Summaries" submenu option under  

    the "Options" menu has a new item called "Save summaries".  Save Summaries generates a summary file for  

    each marked or selected file and saves it as an ASCII text file to the specified destination path.  The  

    file is named with the filename specified or by using the IEEE PSRC long file naming convention.  The  

    summary file extensions are "*.txt". 

 

6.  Data Plotting: Added 2 new buttons to the phasor/circular chart window (uparrow/dowarrow).  The new up arrow 

    and down arrow buttons allow for increasing/decreasing the phasor/circular chart scale independent of the  

    traces.  

 

7.  Data Plotting: Added 2 new buttons to the trace window (uparrow/dowarrow).  The new up arrow and down arrow  

    buttons allow for increasing/decreasing the trace's amplitude independent of the phasor/circular chart.  

 

8.  Data Plotting:  Added 2 new buttons to the trace window (left arrows).  The left arrow to the left of the 

    scrollbar shifts the sample at the databar (vertical solid black line) to the beginning of the window.  The 

    left arrow to the right of the scrollbar shifts the separator bar between the traces and the analog table  

    to the databar. 

 

9.  Data Plotting: Corrected a problem in the "Save As Comtrade" feature when saving the sampling rate information 

to  

    the ".CFG" File.  The problem was occuring after a displayed file was modified by, Change Frequency, Truncate 

    Cycles, Duplicate Cycles, Append and Merge.  Older versions wrote the original sample rate information to the 

    new Comtrade file. 

 

10. Data Plotting: Added a feature that will not display a phase angle in the analog table or in the phasor 

diagram 

    if the channel is DC or Frequency (Hertz).   

 

11. Data Plotting:  Added a limit for analog channels (256 analog channels/display) for the Waveform Merge  

    & Append features.  Can not Append/Merge waveforms if the combined exceeds 256 analog channels or exceeds  

    1024 digital channels. 

 

12. Data Plotting:  Fixed a problem with reading load data times from a Comtrade file that specifies the data   

    in seconds. 

 

  

Wavewin Areva B.R - 10/12/2004  

 



1.  Data Plotting:  Improved the SAC harmonic calculations to include the magnitude and angle.  Previous 

calculations 

    were storing the magnitude value only. 

 

2.  Data Plotting:  Fixed a problem with the DC units in a Comtrade File not showing up in the Analog Table. 

 

3.  Data Plotting:  Took out the display of the phasors in the phasor diagram for analog channels that are not 

Volts,  

    Amps, Watts and Vars.  Also, now displays "N/A" in the Phasor Analog table column for channels that are not 

Volts,  

    Amps, Watts and Vars. 

 

 

Wavewin Areva B.P - 08/21/2004  

 

1.  Data Plotting:  Upgraded the "Save As Comtrade" engine to handle the older 1991 version and the newer 1999  

    version. 

 

2.  Data Plotting:  Added a new field in the "Properties" dialog to select the Comtrade version for the "Save As 

    Comtrade" engine.  The new field is in the "Comtrade" tab and is called "Save Using Comtrade Version:".  

Select 

    1991 for the older version and 1999 for the newer version.  The default version is the newer 1999 version. 

 

 

Wavewin Areva B.P - 06/16/2004  

 

1.  File Manager:  Added a new feature to open multiple waveform files from the file table.  Mark the files  

    desired and select the "Open Marked Files" menu option under the Options/Waveform File(s) menu.  The  

    files will be tiled horizontally and the file manage will be minimized. 

 

2.  File Manager:  Append Waveform Files:  The two features available under the Options/Waveform File(s)/Append  

    menu will append all the marked waveform files in time either by deleting the common times between files  

    (Discard Common Times) or appending all marked files back to back (Back to Back), sorted oldest to latest.   

 

    The files must be of the same type. 

 

3.  File Manager:  Merge Waveform Files:  The two features avaliable under the Options/Waveform File(s)/Merge  

    menu will merge different types of files into one display.   

      By Time: Merge channel samples if they have a common time segment.  The reference time is from the file  

               with latest start date and time. The file with the least amount of samples determined the length  

               of the new merged file. 

      By Sample: Merge regardless of time stamps. The reference time is from the first marked file. And the  

                 file with the least amount of samples determines the length of the file. 

 

    When files with different sampling frequencies are merged a dialog will be displayed.  The dialog contains  



    a list of all the sampling frequencies in the marked files.  Select the frequency for the merged file or  

    enter a new frequency. 

 

    To identify the merged channels the station name for each file is added to the beginning of the analog and  

    digital channel names.  To turn off this feature open the Properties dialog in the data-plotting window.   

    Click on the Append/Merge tab and uncheck the “Add the File’s Station Name to Beginning of the  

    Analog/Digital Channels” field.  

 

4.  Data Plotting:  Added a new feature Append Open Files. There are two options available under the Append  

    Open Files Menu (same feature as the file manager’s Append): 

      Discard Common Times: Any common times found in the open files will be deleted from the oldest file. 

      Back to Back: The files are appended back to back.  No samples are deleted. 

     

    The files must be of the same type.  

 

5.  Data Plotting:  Added a new feature Merge Open Waveform Files. There are three options available under the  

    Merge Open Files Menu: 

      By Time:   Merge channel samples if they have a common time segment.  The reference time is from the file  

                 with latest start date and time.  The file with the least amount of samples determined the  

                 length of the new merged file. 

      Manually:  Use the data bars to highlight where the common sample time is in each window.  Merge manually  

                 will then line up the data bars and adjust the time stamps accordingly. This option is used when  

                 the file times are not synchronized.  The active window determines the time stamp of the new  

                 merged file and the open window with smallest number of samples determines the length of the  

                 new merged file. 

      By Sample: Merge regardless of time stamps and/or data bar positions.  The reference time is from the  

                 active window.  And the file with the least amount of samples determines the length of the file. 

 

    When files with different sampling frequencies are merged a dialog will be displayed.  The dialog contains  

    a list of all the sampling frequencies in the opened files.  Select the frequency for the merged file or  

    enter a new frequency. 

 

    Merging Open Files allows for flexibility of what channels are merged.  Merge Open Files will merge either  

    the marked channels only or if there are no marked channels then it will merge the visible channels. 

 

    To identify the merged channels the station name for each file is added to the beginning of the analog and  

    digital channel names.  To turn off this feature open the Properties dialog.    Click on the Append/Merge  

    tab and uncheck the “Add the File’s Station Name to Beginning of the Analog/Digital Channels” field. 

 

6.  Data Plotting:  Added a menu button to gain easy access to the driver’s data type setting.  The data type  

    setting specifies if the samples for the active driver are saved in RMS values or in instantaneous values. 

 

7.  Data Plotting:  Modified setting the sample time stamps in the Comtrade reader.  If the sampling frequency  

    is set in the .CFG file then the time stamp is calculated from the sampling frequency.  If the sampling  

    frequency is 0 then the time stamp is set from the time stamp in the .DAT file. 



 

8.  Data Plotting:  Fixed a problem with displaying the waveform data and analog table when switching between 

    open windows.  The system was losing the window handels when a left mouse click was encountered. 

 

9.  File Manager:  Added a new feature in the File Menu called "ComName(s) Rename".  This feature will rename all 

    the marked waveform files (file entries displayed in red) using the IEEE long file naming convention 

(ComNames).   

    The format for the ComName Files are:  

       fault date,fault time,time code,station,device,company,duration,type,latitude,longitude,user field.ext 

           

    All files associated with the marked waveform files will be renamed.   

      Comtrade files: the ".CFG", ".INF", ".HDR", ".DAT" and "*.D##" files will be renamed. 

 

10. File Manager:  Added a new feature in the File Menu called "ComName Properties".  There are 4 fields in the 

    ComName format that can not be extracted from the waveform files: "Company Name", "Time Code", "Latitude" and  

    "Longitude". The "ComName Properties" allows for entering these fields prior to renaming. 

 

11. File Manager & Data Plotting:  Added a new feature in the "Save As Comtrade" option to use the ComNames long  

    file naming convention for the Comtrade Name.  There is a new check box inside the "Save As Comtrade" dialog 

    called:  "Use the ComNames Naming Convention to Name the Comtrade File(s)".   

    If checked the system will automatically assign a ComName filename to all Comtade files saved.  If unchecked 

    then the files will be named using the name entered into the "File Name" field. 

 

 

Wavewin Avera B.L - 04/01/2004 

 

1.  Data Plotting:  Added support to read Comtrade files that are distributed into multiple data files. 

 

2.  Data Plotting:  Fixed a problem with displaying SAC values when operating with RMS calibrated data. 

 

3.  File Manager:  Added a new feature to Append like waveform files in time.  A new sub menu 

    has been added to the "Options" menu called "Waveform File(s)".  Use the "Open Selected Waveform  

    File" option to display the traces in the selected file.  Use the "Append Marked Waveform Files" 

    option to append like waveform files in time.  The marked file's analog and digital channels must match. 

 

4.  File Manager:  Added a new feature to set up certain parameters for the append feature. Select the  

    "Waveform Properties" option under the "Waveform File(s)" menu option. To throw out samples with common times 

    check the "Discard Common Times" option.  Next, select what file will have the times discarded from: 

    the new file being created or the files being appended. 

 

5.  Data Plotting:  Added a new setting to set the Opening frequency for each supported driver.   

    To setup this parameter open the desired waveform file, next select the "Change Frequency" option from 

    the "Data" menu and check the "Always Open" box.  The frequency entered into the New Frequency" field 

    will be the frequency displayed for all the files for the active driver. 

 



6.  Data Plotting:  Added a new feature to Show/Hide the event separator bars for multiple event files. The 

    new field is in the "Properties" dialog under the "Display Settings" tab. 

 

7.  Data Plotting: Fixed a problem with displaying leading zeros for the fault time in the Waveform  

    Summary window. 

 

8.  Data Plotting:  Added a new feature to the data plotting's "Data" menu to Truncate cycles.   

    Truncate can be applied to remove cycles from the beginning of the data, the end of the data  

    and from the middle of the data. 

 

9.  Data Plotting:  Added a new feature to the data plotting's "Data" menu to Duplicate the cycle  

    of data between the RMS bar and the data bar.  A dialog box allows for specifing the number of  

    cycles to add. 

 

10. Data Plotting: Added two new features to the data plotting's "Data" menu to change and restore the  

    sampling frequency.      

  

        a.) Change sampling frequency: This feature allows for changing the sampling frequency of the  

            displayed record.  If Sync mode is active then Change Sampling Frequency will change all open  

            windows to the entered frequency. 

 b.) Restore Original Data:  This feature is active only after the sampling frequency is changed.   

            It allows for restoring the original raw data of the displayed record.  If Sync mode is active  

            then Restore Original will restore all the open windows to their original raw data. 

 

11. Data Plotting: Added 3 new options to the "Values" menu. 

 

 a.) Mark Raw Samples - Draws a small circle at all the original raw samples. 

 b.) Mark Peak Values - Draws a small square at all the peaks. 

 c.) Mark Change in Sign Values - Draw a small triangle at all samples where a change in sign occurs. 

 

12. Data Plotting: Modified the Channel Information, Summary and Raw Data menu buttons to indicate an ASCII  

    display with the corresponding character signifying the type of data. 

 

13. Data Plotting: Added a new menu button to open new files or to open one of the last 14 files opened. 

 

14. Data Plotting: The data plotting window's menu has been arranged to be more windows compliant. 

    A large number of requests from Wavewin users asked to improve the menu.  

    Below are the additions: 

 - Added a new "File" menu.  The "File" menu handles all commands directly related to the waveform file. 

        - Added a new "Open" command under the "File" menu to open new waveform files. 

        - The "Data" menu handles all commands relating to the data such as: Expand & Contract Time, Increase  

          & Decrease amplitude, auto scale... 

        - Added a new "Channel" menu.  The "Channel" menu handles all commands directly related to the  

          Analog and Digital channels. 

 



15. Data Plotting: The "Display" dialog used for setting up the properties of the window has been moved to the  

    new "File" menu and is now called "Properties". 

 

16. Data Plotting: The "Displayed Device's Data Type" field in the "Properties" dialog (formally the "Display" 

dialog) 

    has been moved from the "General" tab to the "Display Settings" tab. 

 

17. File Manager: Improved the speed of read engine for the File manager. Enhanced the way  

    the memory is allocated when reading the file allocation table.   

 

 

Wavewin Areva B.F - 01/19/2004 

 

1.  Data Plotting: Fixed a problem reading the sampling frequency in the Comtrade driver.   

    The driver was defaulting the sampling frequency to 0 if it was >32768 or <32768. Took 

    out the limit and open ended the sampling frequency value. 

 

2.  Data Plotting: Added a new feature to save RMS Calibrated data as Peak data for the  

    Save As Comtarde option. This feature is optional. Change the "Convert RMS Calibrated  

    Data" field in the "General" tab of the "Display dialog" to "Yes" to activate. 

 

3.  Data Plotting: Fixed a problem with the "Software Analog Channel" menu disappearing. 

 

4.  Data Plotting: Took out the gray background for the digital channels in the print outs. 

 

 

Wavewin Areva B.A - 10/14/2003 

 

1.  Data Plotting: Allowed for Comtrade Files to be displayed if the digital channels have  

    no original states set. 

 

2.  Data Plotting: Added two new buttons in the phasor/circular chart window title:  

    "P" to display the phasors at the data bar and "C" to display the circular chart. 

 

3.  Data Plotting: Fixed a problem reading Comtrade CFG files that use a line feed only as  

    an end-of-line marker. 

 

4.  Data Plotting: Added support to display Comtrade files that have digital channels only. 

 

5.  Data Plotting: Modified the equation for the fault time bar to have more resolution. 

 

 

Wavewin Areva B.9 - 09/04/2003 

 

1.  Data Plotting: Took out multipling the sample values by -1 in the ABB TPU Cap files. 



 

 

Wavewin Areva B.7 - 08/03/2003 

 

1.  Data Plotting: Improved the error checking on Comtrade files.    

 

2.  Data Plotting: Increased maximum zoom factor for auto-scale mode from 99999 to 999999999 to allow  

    for further magnification.  

 

3.  Data Plotting: Fixed a problem with the auto scale feature for Log files. 

 

4.  Data Plotting (Save Displayed Values): Added a new extension "*.mac" for the Save Displayed Values Feature. 

 

5.  Data Plotting (Save Displayed Values): Allowed for the Display Save Values File and Format File Window to  

    be independent of the data plotting window.  Does not close the Save Values File and Format File Window 

    when closing the data plotting window. 

 

6.  Data Plotting: Enhanced the Fault time bar locator to look for the closes match defined by the selected 

format. 

    Prior versions looked for an exact match. 

   

7.  Data Plotting: Enhanced the Sync Time feature to look for the closes match.  Previous versions looked for 

    an exact match. 

 

8.  Data Plotting: Corrected the Sampling Frequency for Comtrade Files that specify a time scale multiplier. 

 

9.  Data Plotting: Enhanced the Sync Manual Mouse Click to displace the mouse according to time difference.   

    Previous versions displaced according to click position. 

 

10. Data Plotting: Corrected the Fault Time displayed in the Waveform Summary Window. 

 

11. Data Plotting: Added a Prompt to ask to overwrite existing Comtrade files for the Save As Comtrade feature. 

 

12. Data Plotting: Corrected the Save As Comtrade feature to save only the digital channels that are visible. 

    Previous versions were saving the digital channels when the digital section was hidden using the drag mouse. 

   

 

Wavewin Areva B.6 

 

1. Data Plotting: Fixed a problem with the scale factors for the print engine. 

 

 

Wavewin Areva B.5 

 

1. Data Plotting: Advanced the Save Display Values option.  Added user defined Templates. 



   Refer to the Data Plotting help window "Save Displayed Values" section for more information. 

 

2. Data Plotting: Added and new menu option "Values".  Allows for saving Values displayed 

   in the Analog Table to a text file (Mark & Save) in the default format or in the format  

   defined in the selected Template file.  Provides "Open", "New" and "Clear" features for 

   the active Values file and provides "New" and "Open" features for the Template Files.  

   Refer to the Data Plotting help window "Save Displayed Values" section for more information.  

 

3. Data Plotting: Added the Horizontal Bars to the print engine. 

 

4. Data Plotting: Fixed a time scale problem with Comtrade files that specify a time scale multiplier. 

 

 

Wavewin Areva B.4 

 

1. Data Plotting: New time based display.  New field "Trace Display Type" added to the "Display"  

   dialog under the "General" tab. Allows for toggling between a sample base display and the time  

   based display. 

 

2. Data Plotting: New Fault reference time bar.  Shows the time difference from the fault time. 

    

3. Data Plotting: New Close button for the Phasor/Circular Chart window. 

 

4. Data Plotting: New Close button for the Channel Information Table.    

 

 

Wavewin Areva B.3 

 

1. File Manager: Fixed a problem with the SOE table when displaying files with SACs defined. 

 

2. Data Plotting: Fixed a problem with scaling the harmonic values in the Harmonics window. 

 

 

Wavewin Areva B.2 

 

1. Data Plotting: Allowed for the Constants in the SACs to be real values. 

 

2. Data Plotting: Changed the way the digital bits are displayed: a value of 1 = thick green line,  

   a values of 0 = thin black line.  The A and N status next to the digital titles stay  

   the same. They are set according to the bit compared to the original state,  

   A = different then original state, N = same as original state. 

 

3. Data Plotting: Added in the SAC window divide and multpliy operators: 

       division = ':' 

       multiplication = '*'   



        

    example: +1/*2/        - multiply channel 1 to channel 2 

             +1/+2/+3/*^12 - multiply the addition of channel 1,2 and 3 to a constant of 12 

             +1/:2/        - divide channel 1 by channel 2 

             +1/+2/+3/:^12 - divide the addition of channel 1,2 and 3 by a constant of 12 

 

4. Data Plotting: Added in the SAC window the ability to use a constant value for the "+", "-",":" and "*" 

operators.  

     

    example: -12/*^15     - reverse channel 12 and multiply with a constant of 15 

             +2/+3/+4/*^5 - added channel 2,3 and 4 and multiply with a constant of 5 

             +2/+3/+4/:^5 - added channel 2,3 and 4 and divide by a constant of 5 

 

5. Data Plotting: Added phase shifts to the SAC operators mainly for + and - sequence components: 

     

    example: +1/+2@120/+3@240/:^3/  - (+)Seq 

             +1/+2@240/+3@120/:^3/  - (-)Seq 

             +1/+2/+3/:^3/          - (0)Seq 


